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Preface

This document describes the installation procedure of NSFOCUS Remote Security
Assessment System (RSAS), including its hardware edition and virtual edition (VRSAS).

The product informatio
be installed because of

Organization

n involved in this document may slightly differ from your product to
version upgrades or other reasons.

Chapter

Description

1 Product Overview

Provides basic information about RSAS.

2 Installation Procedure

Describes the installation procedures of the hardware edition and virtual
edition of RSAS.

3 Initial Login

Provides instructions for initial configuration of RSAS.

ADefault Parameters

Provides default parameters of RSAS.

Change History

Version Description
V6.0R04F04 First release.
Conventions
Convention Description
Keywords, names of screen elements like buttons, drop-down lists or fields, and
Bold font .
user-entered text appear in bold font.
. Document titles, new or emphasized terms, and arguments for which you supply
Italic font L
values are in italic font.
\ Reminds users to take note.
4
Note
& Indicates a tip to make your operations easier.
Tip

Copyright © NSFOCUS
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Convention

Description

A

Caution

Indicates a situation in which you might perform an action that could result in
equipment damage or loss of data.

4

Warning

Indicates a situation in which you might perform an action that could result in bodily
injury.

A>B

Indicates selection of menu options.

Technical Support

Hardware and Software Support

Email: support@nsfocusglobal.com

Cloud Mitigation Support

Email: cloud-support@nsfocusglobal.com

Phone:

USA: +1-844-673-6287 or +1-844-NSFOCUS

UK: +44 808 164 0673 or +44 808 164 ONSF
Australia: +61 2 8599 0673 or +61 2 8599 ONSF
Netherlands: +31 85 208 2673 or +31 85 208 2NSF
Brazil: +55 13 4042 1673 or +55 13 4042 INSF
Japan: +81 3-4510-8673 or +81 3-4510-8NSF
Singapore: +65 3158 3757

Hong Kong: +852 5803 2673 or +852 5803 2NSF
Middle East: +973 1619 7607

Documentation Feedback

For any query regarding the usage of the documentation, you can contact us:

Email: info-support@nsfocus.com

Copyright © NSFOCUS
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Product Overview

Based on years of practical experience in vulnerability discovery, configuration checking, and
security services, NSFOCUS has developed RSAS, a next-generation vulnerability scanning
and configuration management product.

This chapter provides basic information about RSAS. It contains the following sections:

Section Description

Product Characteristics Describes characteristics of RSAS.

Main Functions Describes major functions of RSAS.

Typical Deployment Describes deployment modes supported by RSAS.

1.1 Product Characteristics

As a next-generation vulnerability scanning and configuration management product, RSAS
can fully detect vulnerabilities on the network, enabling users to quickly identify potential
cyber risks.

All-Round Detection of Vulnerabilities

RASA can comprehensively detect vulnerabilities in IT systems. For example, it can detect
security vulnerabilities in the target hosts, security configuration defects, web application
vulnerabilities, weak passwords, and code defects and identify accounts, services, and ports
that should not be opened in the system.

Graphic Display of Vulnerabilities

By means of NSFOCUS's proprietary security risk calculation method, RSAS analyzes
various vulnerabilities on the network and evaluates the risks, provides an overall security
status assessment, and comprehensively presents security risks in the information system,
forming a complete security risk report. This helps the administrator to discover
vulnerabilities earlier than attackers and fix the vulnerabilities timely.

The analysis result is displayed on the dashboard from perspectives of the risk area, type, and
severity. As a result, you can comprehensively know the security risks, focus on critical areas
and assets, and fix serious vulnerabilities first. Clicking the risk data on the dashboard helps
you to locate vulnerabilities of an IP address.

Copyright © NSFOCUS 3 V6.0R04F04
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Clear Asset Management

RSAS manages assets, which are uniquely identified with IP addresses, by using the risk
view, in which the system and network security status is visualized in real time. When
deploying RSAS, users could define a logical network structure in advance to manage risks
by using either the asset view or the asset repository automatically generated from assessment
tasks.

Asset management includes the following:

®  When performing a scanning task, RSAS automatically detects IP addresses on the
network and updates asset information to the asset repository.

®  You can search the asset repository for the status of network assets.

®  RSAS determines the risk level based on the risk score, which is calculated with the
criticality of assets in the asset repository taken into account.

®  When generating a report, RSAS locates the matched assets for each IP address. Then it
reads and displays the node name and node administrator. In this manner, when a
vulnerability is found in a node, the related node administrator can promptly identify the
vulnerable asset and ask the asset owner to immediately fix the vulnerability.

Diversified Vulnerability and Configuration Databases

NSFOCUS boasts a professional security research team, NSFOCUS Security Team, with full-
time researchers for vulnerability tracking and prospective study. The team has independently
found over 40 vulnerabilities in common images, operating systems, databases, and network
devices and been providing vulnerability-related rule support for world-famous network
security vendors. NSFOCUS Security Team is responsible for maintaining the vulnerability
database and detection rules and performing an upgrade every two weeks. In addition, for
major vulnerabilities, the team can upgrade the vulnerability database and detection rules
within two days after they are first detected.

Taking advantage of NSFOCUS Security Team's research accumulation, the RSAS
knowledge base has over 270,000 vulnerabilities, covering all mainstream underlying
systems, application systems, and network devices. It also provides the configuration
checking base, professional suggestions for remediation, and security configuration checking
standards for multiple industries. The configuration checking base is available for hundreds of
systems, which are divided into seven categories and cover more than 30 products.

RSAS can discover security defects and noncompliant code practices by auditing mainstream
code files.

Identification of Nonstandard Ports

With the advanced nonstandard port identification technology and protocol fingerprint base,
RSAS can identify application service types on nonstandard ports quickly and accurately and
conduct vulnerability checking, effectively avoiding false negatives and false positives during
scanning.

1.2 Main Functions

Baseline security requirements consist of security vulnerability and security configuration
checking items. The coverage and effectiveness of such checking items are crucial to baseline
security.

Copyright © NSFOCUS 4 V6.0R04F04
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Vulnerability Management

According to security management regulations, RSAS provides risk alerting, checking,
management, remediation, and auditing and supervises the implementation of security
management regulations in each phase of the risk management process. RSAS can effectively
and comprehensively detect vulnerability risks on the network, provide professional and
effective analysis and remediation suggestions, and audit remediation effects throughout the
risk management process, as shown in Figure 1-1. RSAS can reduce attacks to the maximum
extent possible and is a "vulnerability management expert".

Figure 1-1 Security management process

v

Vulnerability
alerting

W\ ¢

Vulnerability Vulnerability
audit Vulnerability detection
Management
) 2!
Vulnerability Risk ’
remediation management

Configuration Management

With a complete security configuration database, RSAS helps security configuration and
remediation for IT information systems.

By means of machine languages and the combination of remote detection and local
detection, RSAS can automatically check security configurations and provide detailed
detection reports. Compared with the traditional manual check, this helps reduce the
check time and avoid mistakes.

RSAS integrates leading technologies (including NSFOCUS Intelligent Profile (NSIP))
to detect security configuration issues in network assets automatically, effectively, and
accurately.

With continuous updates and improvement, RSAS is capable of supporting emerging
device types. Check rules are also continuously updated to provide the most
comprehensive automatic configuration checks, reducing risk costs and protecting your

assets.

Copyright © NSFOCUS
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1.3 Typical Deployment
Standalone deployment is recommended for small and medium-sized enterprises, e-
commerce, e-government, educational institutions, and independent Internet Data Centers

(IDCs), which have more centralized data and simpler network topologies (mostly bus or
star).

1.3.1 Deployment in a Small-Scale Network

RSAS can be easily deployed in the security maintenance environment of small-scale
networks to detect various security vulnerabilities in business systems.

Figure 1-2 Deployment of RSAS in a small-scale network

1.3.2 Deployment in a Small and Medium-Scale Network

For small and medium-sized enterprises, their business networks may be divided into multiple
subnets. It is costly to deploy a vulnerability management system on each subnet and also
dangerous to open access permissions for vulnerability management on subnet firewalls. To
cater to this situation, RSAS provides multiple scanning links and ports, each of which can
connect to a subnet without extra firewall rule, as shown in Figure 1-3. This effectively
reduces costs and avoids risks.

Copyright © NSFOCUS 6 V6.0R04F04
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Figure 1-3 Deployment in a small and medium-scale network

. Y

Subnetn 5 - i '

1.3.3 Deployment in a Subnet with Limited Access

In certain circumstances, a business subnet may fail to RSAS, or RSAS cannot be directly
deployed due to too many subnets. To cater to such situations, multiple RSAS devices can be
deployed with TVM, under management of the latter. See Figure 1-4.

Copyright © NSFOCUS 7 V6.0R04F04
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Figure 1-4 Deployment in a subnet with limited access

Subnet 1 Subnet 2 Subnet n
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Installation Procedure

This chapter describes how to install the hardware edition and virtual edition of RSAS. It
contains the following sections:

Section Description
Installing RSAS Describes how to install the hardware edition of RSAS.
Installing vRSAS Describes how to install the virtual edition of RSAS (VRSAS).

2.1 Installing RSAS

This section describes how to install the hardware edition of RSAS.

2.1.1 Hardware Information

RSAS models include RSAS NX3-P (portal), RSAS NX3-A (portal), RSAS NX3-X (1U),
RSAS NX3-S (1U), RSAS NX3-HHA (1U), and RSAS NX3-E (2U).

2.1.2 Hardware Appearance

This section describes the front panels and rear panels of RSAS.

2.1.2.1 RSAS NX3-P (Portable)

Figure 2-1 and Figure 2-2 show the front panel and rear panel of RSAS NX3-P respectively.

Copyright © NSFOCUS 9 V6.0R04F04
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Figure 2-1 Front panel of RSAS NX3-P
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(1) STA: status LED (2) PWR: power LED
(3 SYS: system LED (#) RIJ45 console port
(5) USB port (6) M: management port
(7) Working ports —

Rear Panel

Figure 2-2 Rear panel of RSAS NX3-P
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(1) Power adapter port
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2.1.2.2 RSAS NX3-A (Portable)

Figure 2-3 and Figure 2-4 show the front panel and rear panel of RSAS NX3-A respectively.

Front Panel

Figure 2-3 Front panel of RSAS NX3-A

NSFOCUS RSAS Installation Guide

®

Monitor

Rear Panel

Figure 2-4 Rear panel of RSAS NX3-A

006

f wbocun .

%?Eﬁmmmm;.;
T 11
0006 0 0O O

(1) STA: status LED (2) PWR: power LED

(3 SYS: system LED (#) RIJ45 console port

(5) USB port (6) M: management port

(7) Working ports: electrical Power adapter port

Copyright © NSFOCUS
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(9) Power switch —

2.1.2.3 RSAS NX3-X (1U)

Figure 2-5 and Figure 2-6 show the front panel and rear panel of RSAS NX3-X respectively.

Front Panel

Figure 2-5 Front panel of RSAS NX3-X

(D SYS: system LED (2 PWR: power LED
(3 STA: status LED (#) RIJ45 console port
(5) USB port (6) M: management port
(7) Working ports: electrical —

Rear Panel

Figure 2-6 Rear panel of RSAS NX3-X

P DO

(D  Ground connector (2 Power switch

(3 Power connector —
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2.1.2.4 RSAS NX3-S (1U)

Figure 2-7 and Figure 2-8 show the front panel and rear panel of RSAS NX3-S respectively.
Front Panel

Figure 2-7 Front panel of RSAS NX3-S
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| |

0006 0 0 O
(D RST: reset LED (2) STA: status LED
(3 PWR: power LED (®) SYS: system LED
(5) RJ45 console port (6) M: management port
(7) USB port Working ports: electrical

Rear Panel

Figure 2-8 Rear panel of RSAS NX3-S

(1]

(D Ground connector (2 Power switch

(3 Power connector —

2.1.2.5 RSAS NX3-HHA (1U)

Figure 2-9 and Figure 2-10 show the front panel and rear panel of RSAS NX3-HHA
respectively.

Copyright © NSFOCUS 13 V6.0R04F04
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Front Panel

Figure 2-9 Front panel of RSAS NX3-HHA
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Rear Panel

Figure 2-10 Rear panel of RSAS NX3-HHAFigure 2-9
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(D  Ground connector (2 Fan
(3 Power switch (#) Power connector

2.1.2.6 RSAS NX3-E (2U)

Figure 2-11 and Figure 2-12 show the front panel and rear panel of RSAS NX3-E
respectively.
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Front Panel

Figure 2-11 Front panel of RSAS NX3-E
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Rear Panel

Figure 2-12 Rear panel of RSAS NX3-E
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A\ Y

Note

Hardware parameters may vary slightly with lots and models.

Table 2-1 shows hardware parameters of RSAS models

Table 2-1 Hardware parameters of RSAS

Model

Dimensions
(unit: mm)

W*D*H

Power Supply

Weight

RSAS NX3-P

271*175%44

Single AC power supply
* Input voltage range: 100-240 V
* Input current: 1.6 A

*  Maximum output power: 60 W

2.35kg

RSAS NX3-A

324*220*62

Single AC power supply
* Input voltage range: 100-240 V
* Input current: 2 A

*  Maximum output power: 150 W

3.8kg

RSAS NX3-X

430%390*44

Single AC power supply
* Input voltage range: 100-240 V
* Input current: 0-5 A

*  Maximum output power: 65 W

Skg

RSAS NX3-S

430%390*44

Single AC power supply
* Input voltage range: 110-240 V
* Input current: 1.5-3 A

*  Maximum output power: 250 W

6.7 kg

RSAS NX3-HHA

450*435%44

Single/redundant AC power supply
* Input voltage range: 100-240 V
* Input current: SA

*  Maximum output power: 250
W/300 W

8.5kg

RSAS NX3-E

435*560*88

Redundant AC power supply
. Input voltage range: 100-240 V
. Input current: 5-2.5 A

. Maximum output power: 300 W

11.59 kg

Copyright © NSFOCUS
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Table 2-2 describes LEDs on the front panel.

Table 2-2 LED meanings

LED Type LED Status Description

Power LED (PWR) On The power supply is working.
Off The power supply is unavailable or not working.

Status LED (STA) Blinking The system is reading or writing data.
Off The system is idle.

System LED (SYS) Off The power supply is unavailable or not working.
Green The device is working under a proper load.
Orange The CPU usage of the device is on the high side.
Red The CPU usage of the device is too high.

Network LED  (on | Green
either side of a network | (LINK/ACT)

* Off: indicates that no link is established.

port) *  On:indicates that a link is already established without data
transmission.
* Blinking: indicates that a link is already established and
data transmission is ongoing.
Yellow/Green * On (green): indicates the link works at 100 MB.
Speed
(Speed) *  On (yellow): indicates that the link works at 1000 MB.
* Off: indicates data transmission is lower than 10 MB.
Bypass LED | On The bypass function is enabled for the numbered ports.
(numbered)
Off The bypass function is disabled for the numbered ports.
HDD LED Blinking The hard disk is reading or writing data
Off The hard disk is not inserted.
On The hard disk is idle.
HDD LED Blinking The HDD is reading or writing data.
Off The HDD is not inserted.

2.1.5 Installation Preparations

Before installing RSAS, you need to check accessories and prepare the network environment,
common tools, and equipment room environment.

Copyright © NSFOCUS 17
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Before installation, check that all accessories are included in the accessory kit delivered with
the device. If any accessories are missing or broken, please contact the local distributor.

Accessories vary with the device model. For the specific accessories, see the packing list.

Accessories of 1U Devices

Table 2-3 lists accessories of 1U devices and Figure 2-13 illustrates the appearances of

rackmount accessories.

Table 2-3 Accessories of 1U devices

Accessory

Description

Straight-through  cable

Used to connect a device to the network.

(green)
Crossover cable | Used to connect a PC to the management interface of RSAS so that you can
(yellow) log in to the web-based manager of RSAS to perform configurations.

Power cable

One or two power cables are provided for each device.

Serial cable

A serial cable (one end is the DB9 female connector and the other end is the
RJ45 plug) is required for device configuration via the console port.

Rackmount accessories

Rackmount accessories include the following:

Front mounting ear: fixes the front end of the chassis onto the rack.
Front mounting ear bolt: used with front mounting ears.

Rack rail: adjusts the distance between the device and the rack.
Rack rail bolt: used with rack rails.

Rubber pad: You can cut it into four smaller ones along the dotted line
and attach them to the four corners of or marked places on the device to
avoid abrasion.

Rear mounting ear: fixes rack rails onto the rack.
Rear mounting ear bolt: used with rear mounting ears.

Rack screws and nuts: fixes front and rear mounting ears onto rack
rails.
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Figure 2-13 Accessories for mounting a device onto a 1U rack
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Accessories of 2U Devices

Table 2-4 lists accessories of 2U devices and Figure 2-14 illustrates the appearances of
rackmount accessories.

Table 2-4 Accessories of 2U devices

Accessory Description

Straight-through cable | Used to connect a device to the network.

(green)

Crossover cable | Used to connect a PC to the management interface of RSAS so that you can
(yellow) log in to the web-based manager of RSAS to perform configurations.
Power cable One or two power cables are provided for each device.

Serial cable A serial cable is required for device configuration via the console port.

Rackmount accessories | Rackmount accessories include the following:

*  Front mounting ear: fixes the front end of the chassis onto the rack.
*  Front mounting ear bolt: used with front mounting ears.

* Rackrail: adjusts the distance between the device and the rack.

* Rack rail bolt: used with rack rails.

*  Rubber pad: You can cut it into four smaller ones along the dotted line
and attach them to the four corners of or marked places on the device to
avoid abrasion.

*  Rear mounting ear: fixes the rail onto the rack.
*  Rear mounting ear bolt: used with rear mounting ears.

*  Rack screws and nuts: fixes front and rear mounting ears onto rack rails.
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Figure 2-14 Accessories for mounting a device onto a 2U rack
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2.1.5.2 Network Environment

Table 2-5 describes the network environment required for RSAS to go live.

Table 2-5 Items required for setting up a network environment

Item

Description

IP address

IP address reserved for RSAS.

Computer

Directly connected to the management port of RSAS so that you can log in to the web-
based manager of RSAS in HTTPS mode for management.

Terminal software

Software used for connecting to the console port, for example, HyperTerminal that
comes with the Windows operating system.

Browser

*  The latest Firefox, Chrome, or Microsoft Edge browser are recommended.
*  The recommended screen resolution is 1280 x 1024 or greater.

*  You should clear the Turn on Pop-up Blocker check box on the browser.

2.1.5.3 User-provided Tools and Devices

ESD wrist strap

Tape

Screwdrivers and screws of various specifications

Instruments and meters such as the terminal and multimeter

2.1.5.4 Installation Environment

Table 2-6 lists specific requirements for the installation environment.
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Item Requirements

Temperature: 0°C-45°C

Temperature and humidity * Good ventilation and cooling system

Relative humidity: 10%—-95% (non-condensing)

Use a dust-proof room.

board.

Electrostatic discharge (ESD) + Make sure that the device and floor are well grounded.

Wear ESD gloves or wrist straps when handling the circuit

Executive standards for radiation Class A, EN55022, FCC Part 15

Rack The rack must be secure enough and fit for the device.

2.1.6 Installation Methods

This section describes how to install the device onto the rack.

2.1.6.1 Installation Procedure

Figure 2-15 shows the installation procedure.

Figure 2-15 Installation flow chart

C Start )

'

Install the device on the rack

'

Connect the ground wire

'

Connect the power cable

'

Check the installation

'

Switch on power Troubleshoot

t

Switch off power
Yes

Connect the device to the network

'

Check the installation

'

( End )
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2.1.6.2 Mounting a Device onto the Rack

1U Device

Step1

The appearances and numbers of rackmount accessories for 1U and 2U devices are shown in
Figure 2-13 and Figure 2-14 respectively.

To mount a 1U device onto the rack, follow these steps:
Install front mounting ears.
Fix front mounting ears () with bolts (@) on the left and right sides of the device in the

front end (three screws at each side, total six). See Figure 2-16.

Figure 2-16 Installing front mounting ears

-

1

Step 2 Install rack rails.

Install four nuts (@) at the rear end of the chassis (two nuts on either side). Take rack rails
(®) out of the accessory kit and fix them onto the chassis with four screws (&) (two on either
side). See Figure 2-17.
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Figure 2-17 Installing rack rails
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Step 3 Mount the device onto the rack.

Install four nuts (@) at the front end of the chassis (two nuts on either side). Place the device
on the rails already installed on the chassis and fix it with four screws () (two on either
side). See Figure 2-18.

Figure 2-18 Mounting the device onto the rack
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—End

2U Device

To mount a 2U device onto the rack, follow these steps:

Step 1 Install front mounting ears.
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Fix front mounting ears () with bolts (@) on the left and right sides of the device in the
front end (four screws at each side, total eight). See Figure 2-19.

Figure 2-19 Installing front mounting ears

1

7

Step 2 Install rack rails.

Install four nuts (@) at the rear end of the chassis (two nuts on either side). Take rack rails

(®) out of the accessory kit and fix them onto the chassis with four screws (&) (two on either
side). See Figure 2-20.

Figure 2-20 Installing rack rails
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Step 3 Mount the device onto the rack.

Install four nuts (@) at the front end of the chassis (two nuts on either side). Place the device
on the rails already installed on the chassis and fix it with four screws () (two on either
side). See Figure 2-21.
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Figure 2-21 Mounting the device onto the rack

4 H |

3

walala

SN 500000 000

walolnalnlnafa]n

a

000 000000000000

—End

2.1.6.3 Connecting the Power Cable

RSAS supports both AC and DC power supplies.

Connecting the AC Power Cable

Step1
Step 2
Step 3

Step 4
Step 5

To connect the AC power cable, follow these steps:
Make sure that the device is properly grounded.
Turn the power switch of the AC power module to the OFF position.

Connect one end of the power cable to the AC power socket on RSAS and the other end to the
power socket of the equipment room.

Turn the power switch of the AC power module to the ON position.
Check the status of the power LED on the front panel.

For the status meanings of the power LED, see Table 2-2.

--—--End

Connecting the DC Power Cable

The input DC voltage of security devices is —48 V. Before installing an RSAS device, ensure
that the power supply specifications of the equipment room meet the requirements of the
product, avoiding product damage.

Different devices or models have different DC power sockets that may require a Positronic
connector or a binding post.

Positronic Connector

For a Positronic connector, the procedure is as follows:
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Step1 Make sure that the power switch of the device is in the OFF position.
Step 2 Take out the power plug from the packing case.

Figure 2-22 shows the power socket appearance. A DC power supply includes a power cable
packed in the accessory kit and a socket integrated in the power supply module.

Figure 2-22 Sockets for Positronic connectors

Step 3 Insert the lead wires of the 48 V DC power supply of the equipment room into the jacks of a
DC power supply socket on the device.

Step 4 In the case of dual power supplies, repeat Step 3 to connect the other power cable.

—End

Binding Post

For a binding post, the procedure is as follows:
Step1 Make sure that the power switch of the device is in the OFF position.
Step 2 Take out the power plug from the packing case.

Figure 2-23 shows the power socket appearance. A DC power supply includes a power cable
packed in the accessory kit and a socket integrated in the power supply module.
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Figure 2-23 Binding post terminals

Step 3 Insert lead wires of the 48 V DC power supply of the equipment room into two jacks of the
DC power supply socket of the device.

Ensure that lead wires are inserted into proper jacks. The positive (+) is connected to the
anode (0 V) with the black wire and the negative (—) to the cathode (—48 V) with the red wire.

Step 4 Insert the DC power plug into the DC power socket, and tighten the two screws at both ends
of the plug with a screw driver.

Step 5 In the case of dual power supplies, repeat Step 3 and Step 4 to connect the power cable to the
other DC power supply.

—End

2.1.6.4 Connecting the Network Cable

Connect one end of an Ethernet cable or optical fiber to the electrical or optical port (optical
module is required) on RSAS and the other end to the network port on the peer device. After
RSAS is powered up, check the status of network port LEDs on its front panel. For the
meanings of status LEDs, see Table 2-2.

2.1.6.5 Shutting Down the Device

Turn the power switch to the OFF position to power off the device.

2.1.7 Notes Concerning Scrap Products

To protect the environment, you have the following responsibilities when disposing of
products whose lifecycle has expired:

®  Separate them from household waste and then deliver them to a qualified recycling
station.
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®  The treatment method should conform to national laws and regulations concerning
comprehensive utilization of the resources, environment protection, labor safety, and
safeguarding human health.

® Do not use any technique or process that has been explicitly announced for elimination
to dispose of waste electrical and electronic products.

2.2 Installing vRSAS

This section describes how to install the virtual edition of RSAS (VRSAS).

2.2.1 Configuration Requirements

VvRSAS should run on a host with the virtual machine software installed. Make sure that the
hardware meets all requirements listed in Table 2-1 and the virtual machine meets those listed

in Table 2-2.

Table 2-1 Hardware configuration requirements

Hardware CPU Memory | HDD NIC USB Port
Recommended x86 series (3.2 GHz | 16 GB or | 500 GB | 10/100/10 | USB 3.0 or
configuration 8-core or faster) more or more | 00 Mbps earlier
Minimum configuration for | x86 series (2.4 GHz | 4 GB 150 GB
common scanning tasks dual-core)
Minimum configuration for | x86 series (2.4 GHz | 8 GB 150 GB
image scanning tasks quad-core)
Minimum configuration for | x86 series (2.4 GHz | 16 GB 500 GB
code audit tasks octa-core)
Minimum configuration for | x86 series (2.4 GHz | 4 GB 500 GB
agent-aided full scan quad-core)
Table 2-2 Software configuration requirements
Platform Version
VMware Workstation Version 9.0 or later
VMware vSphere ESXi Version 6.0 or later
FusionCompute V100R005C10SPC700
Standard KVM 2.11.1
Standard OpenStack 3.142
XenServer 7.3.0
Copyright © NSFOCUS 28 V6.0R04F04
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Running multiple VMs on a host will degrade the performance of vRSAS.
Therefore, you are advised to shut down unused ones.

A * If dual hard disks are installed, the first one must be larger than 4 GB.

Caution *  The VM CPU with two cores slows down the scanning. To improve the scanning
speed, you are advised to use a VM CPU with four or more cores, and the number
of CPU cores must be the same as that authorized by the license.

2.2.2 Installation Procedure

Figure 2-24 shows the installation procedure.

Platforms such as OpenStack and Xen do not support dongle authentication. Therefore, you
are advised to use a centralized authentication and authorization (CAA) management platform
or NSFOCUS security cloud for the authentication.

Figure 2-24 Installation process

C Start )
Y

Obtain the image file

!

Create a virtual machine

v

Install the image file

v

Perform initial configuration

v

Conduct license-based authentication

v
( End )

2.2.3 Installation on VMware Workstation
This section describes how to install VRSAS on VMware Workstation.
2.2.3.1 Preparations

Table 2-3 lists preparations to be made for installing vVRSAS on VMware Workstation.
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Table 2-3 Preparations to be made for installing VRSAS on VMware Workstation

Item Description
VMware IP address IP address of a computer that can properly connect to the network.
Workstation
host Account Account with privileges of a system administrator.
vRSAS CD Contains an image file (.iso) of VRSAS.
IP address IP address of the scan interface of vVRSAS.

Authentication | +  License that enables vVRSAS to be launched properly.

license . L
*  Unique authorization hash value granted to vRSAS.

* [P address of a CAA platform and license of VRSAS.

* License of VRSAS for authentication by NSFOCUS security
cloud.

*  Dongle and license: The dongle should be already installed on
the VMware Workstation host.

S,

Note

You can select any one of the three authentication modes.

2.2.3.2 Installation Procedure

Obtaining the Image File of vRSAS

Insert the CD into the CD-ROM drive. The CD runs automatically. Click Remote Security
Assessment System under Installation File. The folder that contains the image file appears.

Creating a VM

To create a VM, follow these steps:
Step1 Start VMware Workstation 14.

The home page of VMware Workstation 14 appears, as shown in Figure 2-25.

Copyright © NSFOCUS 30 V6.0R04F04



z =

- -NSFOCUS

NSFOCUS RSAS Installation Guide

Figure 2-25 Home page of VMware Workstation 14

File Edit View VM Tabs Help |

Library x

Q Type here to search -

@ (8 My Computer
Shared VMs

vmware

WORKSTATION 14

+ 03

Create a New Open a Virtual
Virtual Machine Machine

)

Connectto a
Remote Server

Step 2 Choose File and click Create a New Virtual Machine.

Step 3 In the New Virtual Machine Wizard dialog box, select Custom (advanced) and click Next.

Copyright © NSFOCUS

31

V6.0R04F04



==

= NSFOCUS

NSFOCUS RSAS Installation Guide

Figure 2-26 Selecting a configuration type

>
New Virtual Machine Wizard - - g

.14

WORKSTATION

y

Welcome to the New Virtual
Machine Wizard

What type of configuration do you want?

(") Typical (recommended)

Create a Workstation 14.x virtual machine
in a few easy steps.

(@ Custom (advanced):

Create a virtual machine with advanced
options, such as a SCSI controller type,
virtual disk type and compatibility with
older VMware products.

< Back [ Next > ][ Cancel ]

Step 4 In the Choose the Virtual Machine Hardware Compatibility dialog box, select
Workstation 14.x for Hardware compatibility, and then click Next.
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Figure 2-27 Selecting a compatible workstation version

New Virtual Machine Wizard S

- [

Choose the Virtual Machine Hardware Compatibility
Which hardware features are needed for this virtual machine?

Virtual machine hardware compatibility
Hardware compatibility:

Workstation 14.x

v
Compatible with: ESX Server
Compatible products: Limitations:
Fusion 10.x - 64 GB memory -
Workstation 14.x 16 processors
10 network adapters
8 TB disk size

< Back ][ Next > ][ Cancel

Step 5 In the Guest Operating System Installation dialog box, select Installer disc image file
(iso), browse to the vVRSAS image file in the CD, and click Next.
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Figure 2-28 Choosing to install from an image file

o~ N
New Virtual Machine Wizard I — - @

Guest Operating System Installation

A virtual machine is like a physical computer; it needs an operating
system. How will you install the guest operating system?

Install from:

() Installer disc:

o4 DVD RW 1EZh3E (E2)

@) Installer disc image file (iso):

D:\nsfocus-product.iso v

A Could not detect which operating system is in this disc image.
You will need to specify which operating system will be installed.

() I will install the operating system later.
The virtual machine will be created with a blank hard disk.

[ < Back ][ Next > J[ Cancel J

Step 6 In the Select a Guest Operating System dialog box, select Linux as the guest operating
system (OS) and Other Linux 2.6.x kernel for Version, and then click Next.
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Figure 2-29 Selecting a guest OS and version

»
New Virtual Machine Wizard - @

Select a Guest Operating System
Which operating system will be installed on this virtual machine?

Guest operating system

() Microsoft Windows
@) Linux

(") Novell NetWare
() Solaris

(") VMware ESX

() Other

Version

[ﬁother Linux 2.6.x kernel v]

| <Back || Next> || cancel |

Step 7 In the Name the Virtual Machine dialog box, specify a name for the virtual machine and an
installation location, and then click Next.
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New Virtual Machine Wizard - @

Name the Virtual Machine
What name would you like to use for this virtual machine?

Virtual machine name:

nsfocus-product

Location:

D:\nsfocus-product

The default location can be changed at Edit > Preferences.

[ < Back ][ Next >

J |

Cancel
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Step 8 In the Processor Configuration dialog box, configure processors according to the minimum
requirements listed in Table 2-1, and click Next.
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Figure 2-31 Configuring processors

e y

New Virtual Machine Wizard L X

Processor Configuration
Specify the number of processors for this virtual machine.

Processors

Number of processors: [4 v]
Number of cores per processor: [ 1 v]
Total processor cores: 4

< Back ][ Next > ][ Cancel

Step 9 In the Memory for the Virtual Machine dialog box, configure memory according to the
minimum requirements listed in Table 2-1, and click Next.
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Figure 2-32 Specifying the memory size

g N

New Virtual Machine Wizard L

Memory for the Virtual Machine
How much memory would you like to use for this virtual machine?

Specify the amount of memory allocated to this virtual machine. The memory size

must be a multiple of 4 MB.
€4 GB Memory for this virtual machine: 4096 = MB
32GB
16 GB
8 GB < ,
see [ Maximum recommended memory:
B 9.7GB
1GB
512 MB [@ Recommended memory:
255 MB g 256 MB
128 MB
64 MB [J Guest OS recommended minimum:
32 MB < 32MB
16 MB
& MB
4MB

[ < Back J[ Next > J[ Cancel J

Step 10 In the Network Type dialog box, select Use bridged networking and click Next.
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Figure 2-33 Selecting a network type

’
New Virtual Machine Wizard S r— &

Network Type
What type of network do you want to add?

Network connection

@ Use bridged networking:
Give the guest operating system direct access to an external Ethernet
network. The guest must have its own IP address on the external network.

(") Use network address translation (NAT)
Give the guest operating system access to the host computer's dial-up or
external Ethernet network connection using the host's IP address.

() Use host-only networking
Connect the guest operating system to a private virtual network on the host

computer.

(7) Do not use a network connection

< Back ][ Next > ][ Cancel

Step 11 In the Select I/O Controller Types dialog box, select LSI Logic and click Next.
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Figure 2-34 Selecting 1/O controller types

-
New Virtual Machine Wizard Jr— -

Select 1/0 Controller Types
Which SCSI controller type would you like to use?

1/O controller types
SCSI Controller:

() BusLogic (Maximum disk capacity: 2 TB)

.......

(©) LSI Logic SAS

| <Back || mNext> || cancel |

—

Step 12 In the Select a Disk Type dialog box, select SCSI (Recommended) and click Next.
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Figure 2-35 Selecting a disk type

p
New Virtual Machine Wizard -

=

Select a Disk Type
What kind of disk do you want to create?

Virtual disk type

(C) SATA
NVMe

j/' NVMe disks are not supported by Other Linux 2.6.x kernel.

[ < Back ][ Next >

| [ Cancel

]
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Step 13 In the Select a Disk dialog box, select Create a new virtual disk and click Next.
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Figure 2-36 Selecting a disk

-
New Virtual Machine Wizard S -

Select a Disk
Which disk do you want to use?

Disk
@) Create a new virtual disk

A virtual disk is composed of one or more files on the host file system, which
will appear as a single hard disk to the guest operating system. Virtual disks
can easily be copied or moved on the same host or between hosts.

(") Use an existing virtual disk
Choose this option to reuse a previously configured disk.

(") Use a physical disk (for advanced users)

Choose this option to give the virtual machine direct access to a local hard
disk. Requires administrator privileges.

| <Back || Next> || cancel |

—

Step 14 In the Specify Disk Capacity dialog box, set the maximum disk size, select Split virtual disk
into multiple files, and click Next.
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Figure 2-37 Specifying the disk capacity

>
New Virtual Machine Wizard S - &

Specify Disk Capacity
How large do you want this disk to be?

.

Maximum disk size (GB): 200.0 -
Recommended size for Other Linux 2.6.x kernel: 8 GB

(] Allocate all disk space now.

Allocating the full capadity can enhance performance but requires all of the
physical disk space to be available right now. If you do not allocate all the space
now, the virtual disk starts small and grows as you add data to it.

() Store virtual disk as a single file
@) Split virtual disk into multiple files

Splitting the disk makes it easier to move the virtual machine to another computer
but may reduce performance with very large disks.

| <Bak | [ Mext> [ Concel |

Step 15 In the Specify Disk File dialog box, specify a disk file and click Next.
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Figure 2-38 Specifying a disk file

-
New Virtual Machine Wizard L 8

Specify Disk File
Where would you like to store the disk file?

Disk file

A 100 GB virtual disk be created using multiple disk files. The disk files will be
automatically named based on this file name.

nsfocus-product.vmdk

[ < Back ][ Next > ][ Cancel ]

Step 16 In the Ready to Create Virtual Machine dialog box, click Finish to complete creation of the
virtual machine.
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Figure 2-39 Virtual machine created for vVRSAS

-,
New Virtual Machine Wizard @

Ready to Create Virtual Machine

Click Finish to create the virtual machine. Then you can install Other Linux
2.6.x kernel.

The virtual machine will be created with the following settings:

Name: nsfocus-product -
Location: D:\nsfocus-product
Version: Workstation 14.x

Operating System: Other Linux 2.6.x kernel

m

Hard Disk: 100 GB, Split
Memory: 4096 MB

Network Adapter: Bridged (Automatic)
Other Devices: 4 CPU cores, CD/DVD, USB Controller, Printer, Sound... ~

Customize Hardware... ]

—End

Installing the Image File of vRSAS
To install the image file of vVRSAS, follow these steps:
Step1 Start VMware Workstation 14.
The home page of VMware Workstation 14 appears, as shown in Figure 2-25.

Step 2 Choose VRSAS (nsfocus-product in this document) from the left navigation tree and click
Power on this virtual machine.
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Figure 2-40 Selecting VRSAS to be installed
B T == =

File | Edit View VM Tabs Help | P ~ o SO m |
ey x 1A} Home (71 nsfocus-product
Q Type here to search -

@ nsfocus-product

= [ My Computer
| & esaiosinan: I Pover on s vitus macine |
(51 Fo4 S1Edit virtual machine settings
(] WSM-V6.0R00F01_v12
(] WSM-V6.0R00F01 v12_2
(51 WSM-V6.0R00FO1

-\ 4GB
o :

Shared VMs [ Processors

v Devices

{2 Hard Disk (SCSD) 100 GB
*)CD/DVD (IDE) Using file DAns...

& Network Adapter Bridged (Auto...

USB Controller Present

@) Sound Card Auto detect

(1 Printer Present

B Display Auto detect

¥ Description
Type here to enter a description of this virtual
machine.

v Virtual Machine Details
State: Powered off
Configuration file: D:\nsfocus-product\nsfocus-productvmx
Hardware compatibility: Workstation 14.x virtual machine
Primary IP address: Network information is not available

Step 3 On the installation page, select Install.
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Figure 2-41 vRSAS installer boot menu

NSFOCUS RSAS installer boot menu

[ Jnstall
fdvanced options >

7= NSFOCUS

Step 4 On the welcome page, select Start Installation.

Figure 2-42 Starting to install VRSAS

NSFOCUS Image Installer
Helcome to NSFOCUS RSAS Image Installer

HStart Installation>

Step 5 After the system completes the check of VM configurations, select Next.
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Figure 2-43 Checking configurations

NSFOCUS Image Installer
Checking memory size...

Memory size = 3.85G
The memory meets the reguirement.

Checking disks...

Hard disks detected and found to meet the reguirement.

Checking NICs...
NIC intel_e1000 is supported.

Checking CPUs...
The CPU has 4 cores and meets the reguirement.

> < Back >

Step 6 Specify the boot drive location and select OK.

Figure 2-44 Specifying the boot drive location

NSFOCUS Image Installer
Set Boot Disk Location

[

< Back >

Step 7 Specify the data disk location and select OK.
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Figure 2-45 Specifying the data disk location

Set Data Disk Location (the disk should he larger than
100 GB)

NSFOCUS Image Installer

< Back >

\,

Note

The "later install" prompt indicates that there is only one virtual disk, which is smaller
than 150 GB, and the subsequent system startup verification fails. In this case, you need
to manually add a disk larger than 150 GB after completing all installation procedures
and turning off vVRSAS.

Step 8 Specify a method for obtaining the management interface IP address and select OK.
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Figure 2-46 Configuring an IP address for the management interface

NSFOCUS Image Installer
configure Management Interface IP Assignment Mode

| BAuto assignment via DHCP
2 Manual configuration

< Back >

vRSAS starts to be installed, as shown in Figure 2-47.

Figure 2-47 Installing the image file of VRSAS

NSFOCUS Image Installer
Installing the image to /dev/sda...
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Step 9 After the installation is complete, select OK.

Figure 2-48 Installation completed

NSFOCUS Image Installer
Image installation is complete. Thank you for choosing
NSFOCUS products.
The system is about to shut down, and please manually
switch to hoot the system wia the boot disk.

Step 10 Add a network adapter.

VvRSAS only provides one network interface (that is, management interface) by default. You
need to add a network adapter to enable the scan interface.

a. Choose the vVRSAS image from the left navigation tree, as shown in Figure 2-40.
b. Choose VM > Settings.
The Virtual Machine Settings dialog box appears.

\ The network adapter matches the management interface of vVRSAS. Network adapters
2—7 match scan interfaces eth1-6 of vRSAS.
Note
c. Click Add.

The Add Hardware Wizard appears, as shown in Figure 2-49.
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Add Hardware Wizard

S

Hardware Type

Hardware types:

it Hard Disk
+)CD/DVD Drive

(=1 Floppy Drive

. Network Adapter

USB Controller

&) sound Card

B Parallel Port

&8 serial Port

(=) Printer

Generic SCSI Device

[a1]
\

What type of hardware do you want to install?

Explanation
Add a network adapter.

[ Next> || cancel |

d. Inthe Add Hardware Wizard dialog box, select Network Adapter and click Finish to
return to the Virtual Machine Settings page.

e.  On the page shown in Figure 2-50, select Network Adapter 2. In the Device status area,
select the Connect at power on check box. Configure the network connection mode as

required.
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Figure 2-50 Configuring the network adapter 2

Virtual Machine Settings
[ Hardware | Options
Device p— | Device status
#48 Memory 4.3G8 onnected
[ Processors 4 |¥| Connect at power on
&=iHard Disk (SCSI)  8GB
JCODVD (IDE)  Using file R:\rsas-sys-V6.0R04F04.iso Network connection
@ Network Adapter Bridged (Automatic) Q) Bridged: Connected directly to the physical network
@Network Adapter2 Bridged (Automatic) Replicate physical network connection state
@ ) Sound Card Auto detect
3| pisplay Auto detect NAT: Used to share the host's IP address

Host-only: A private network shared with the host
Custom: Spedific virtual network

VMnet0

)

dged)

LAN segment:

[LAN Segments... ] [Advanced...

[ Ay Add... ][ Remove

f.  Click OK to finish the creation of the network adapter.
g. (Optional) Add other network adapters as required.

—End

Performing Initial Configuration

To perform the initial configuration of VRSAS, follow these steps:

Step1 Start VMware Workstation 14.

The home page of VMware Workstation 14 appears, as shown in Figure 2-25.

Step 2 Log in to the console.

a. Choose VRSAS from the left navigation tree, as shown in Figure 2-40.
b. Choose VM > Power > Start Up Guest to start vVRSAS.

\ Y

Note

When started for the first time, VRSAS will be automatically installed. This will take
several minutes. In other cases, the window shown in Figure 2-51 automatically opens.
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Figure 2-51 Console

/o,

PN
Version 6.8
NSFOCUS Remote Security Assessment System
Copyright (C) 1999-2819
NSFOCUS Corporation, All rights Reserved

http://www.nsfocus.com.cn

AN ___ PP
N/ PP PV A A A N
/71 VAN SN A A S A F A S A S A
\

NN NI NI 1

Welcome to use RSAS at 21:52:84

RSAS login:

c.  Type the console user name and password (initially conadmin for both) and press Enter.

Then the configuration window appears, as shown in Figure 2-52.

Figure 2-52 Console configuration window

conadMin user management System Administration

System Administration System management and configurati

Network Settings on.
Network Diagnosis

System Status

License Information

Backup and Restore

Back

Step 3 Configure network settings.

a. Choose Network Settings > Set Scan Interface > Set Scan Interface 1.
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b. In the window shown in Figure 2-53, use the left arrow («) or right arrow (—) to select
an [P address allocation method (static or dhep). In the case of static configuration, further
configure the IP address, netmask, and gateway of the scan interface eth1.

* The network adapter matches the management interface of VRSAS. Network
\ adapters 2—7 match scan interfaces eth1—6 of vVRSAS.
Ry

* For static IP address allocation, you need to manually configure an IP address. For
Note DHCEP, the DHCP server automatically allocates an IP address. In this case, VRSAS
must properly connect to the DHCP server.

Figure 2-53 Configuring network settings

Set Scan Interface | Set Scan Interfacel

Set Scan Interfacel

Set Scan Interface2
Set Scan Interface3
Return

Set Scan Interface

This is the method to get ipv4, please use <—— or —--> to change
allocation method.

ipv4 allocation method [ETI8LY

ipv4 address [18.65.199.116
ipv4 netmask [255.255.255.8
ipv4 gateway [18.65.199.254
ipv6 allocation method [dhcp

ipv6 address [

ipvb prefix [

ipvb gateway [

NIC negotiated rate [1868
negotiated Mode [auto

ESC:Quit Tab:SwitchPoint Enter :0k

c. Press Enter to save the settings.

Step 4 (Optional) On the host, configure an IP address that is in the same network segment as the IP
address of the eth] interface. In addition, ensure the network connectivity of the host.

—End

Conducting License-based Authentication

Mounting the Dongle
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A Do not remove the dongle when VRSAS is in use. Otherwise, VRSAS would
Caution automatically exit.

To mount the dongle, follow these steps:
Step 1 Insert the dongle in the VMware Workstation host.

Step 2 Choose VM > Removable Devices > Philips USB device > Connect (Disconnect from host)
to connect the dongle to VRSAS.

Figure 2-54 Message prompting dongle connection

nsfocus—product — YHware Yorkstation I

@™ A USB device is about to be unplugged from the
"O'I host and connected ko this virtual machine. It will
s first be stopped to enable safe remaval, With some
devices, the host may display the message "The
device can now safely be removed."

™ Do not show this message again

QK I Cancel

Step 3 Select the Do not show this message again check box and click OK.
Step4 Choose VM > Removable Devices > Philips USB device > Show in Status Bar.

In the dialog box shown in Figure 2-55, select the Do not show this hint again check box
and click OK.

Figure 2-55 Removable Devices dialog box

—
Bemovable Devices m I

The following devices can be connected to this virtual machine using
the status bar or choosing ¥YM > Removable Devices:

i Philips Elite4 S.x {connected to nsfocus-product)

Each device can be connected either to the host or to one virtual
machine at a time.

I Do not show this hint again
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Step 5 (Optional) Disable the power saving mode of the USB port.

Choose Start > Control Panel > Device Manager, expand Universal Serial Bus
controllers, and double-click Generic USB Hub or USB Root Hub. In the Generic USB
Hub Properties dialog box, click the Power Management tab and clear the Allow the
computer to turn off this device to save power check box.

Figure 2-56 Power management

File Action View Help

e | @ E HE| &R %S

" Keyboards Generic USB Hub Properties esl] -
W Memory devices

) Mice and other pointing devices [General [ Driver l Details l Evems] Power Management

| Monitors

¥ Network adapters Generic USB Hub

a

3 Other devices

‘| Base System Device
Y3 Ports (COM & LPT) [ Allow the computer to tum off this device to save power
d=h Print queues Allow this device to wake the computer
D Processors
{28 Sensors

I Software devices
% Sound, video and game controllers
&5 Storage controllers
1M System devices

4 Universal Serial Bus controllers
Generic USB Hub
Generic USB Hub
Standard Enhanced PCl to USB Host Controller
Standard Universal PCl to USB Host Controller
Standard USB 3.0 eXtensible Host Controller - 01
USB Composite Device

USB Root Hub
USB Root Hub

USE Root Hub (xHCI) OK ] [ Cancel i

m

aee e e ee e

—End

Importing a License

VRSAS can be activated only after a license is imported.

For details about authentication by a CAA platform and authentication by NSFOCUS security
cloud, see Conducting License-based Authentication. To import a license, follow these steps:

Step1 Access VRSAS by typing https://IP address of scan interface ethl in the address bar.

A page for authentication mode selection then appears, as shown in Figure 2-57.
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Figure 2-57 Authentication mode selection page

== NSFOCUS

License

@ seiect authentication mode

B o)

Centralized Security cloud-side
authorization authentication

El

ESP-L certification

Device Hash: ~String provided to NSFOCUS (support@nsfocusglobal comm) for generating a license for use
of this device.

Technical Support: ~400-813-6868

Vendor URL: ~ hitps:/Aww.nsfocus.com

Step 2 Select License-based authentication and click Next.

Figure 2-58 License import page

=" NSFOCUS EY

License

The certificate does not exist. Please import the certificate
e device hash Is FAD1-EED3-4574-28E4

Upload License® L Click to Upioad

Device Hash:  String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use
ofhi

vice.

Technical Support:  400-818-6868

Vendor URL:  Nitps:/w

Step 3 Browse to a valid license and click Import.

Step 4 After the license is successfully imported, a dialog box prompting the import success appears.
In this dialog box, click OK.

Copyright © NSFOCUS 58 V6.0R04F04



B=-NSFOCUS NSFOCUS RSAS Installation Guide

Figure 2-59 License imported

= NSFOCUS @ License impor

Step 5 On the RSAS login page that appears, type the user name and password.
-—-End

2.2.3.3 Uninstallation Procedure

To delete VRSAS from VMware Workstation 14, follow these steps:
Step1 Start VMware Workstation 14.
The home page of VMware Workstation 14 appears, as shown in Figure 2-25.
Step 2 Choose VRSAS from the left navigation tree.
Step 3 Choose VM > Power > Shut Down Guest to shut down vRSAS.
Step 4 Choose VM > Manage > Delete from Disk to delete vVRSAS from the hard drive.
VRSAS is then completely removed from the datastore.

—End

2.2.4 Installation on VMware vSphere ESXi

This section describes how to install VRSAS on VMware vSphere ESXi.

2.2.4.1 Preparations

Table 2-4 lists preparations to be made for installing vRSAS on VMware vSphere ESX.

Table 2-4 Preparations to be made for installing VRSAS on the ESXi platform

Item Description

VMware  vSphere | IP address | IP address of a computer that can properly connect to the network.

ESXi server
Account Account with privileges of a system administrator.

vRSAS CD Contains an image file (.iso) of VRSAS.

IP address | IP address of the scan interface of VRSAS.
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Item Description
Authentic License that enables VRSAS to be launched properly.
ation
license Unique authorization hash value granted to vVRSAS.

IP address of a CAA platform and license of vRSAS.

License of VRSAS for authentication by NSFOCUS security
cloud.

Dongle and license: The dongle should be already installed on the
VMware vSphere ESXi server.

S,

Note

You can select any one of the three authentication modes.

2.2.4.2 Installation Procedure

Obtaining the Image File of vRSAS

For how to obtain the image file of VRSAS, see Obtaining the Image File of vVRSAS.

Creating a VM

To create a VM, follow these steps:

Step1 Log in to the ESXi platform.

The ESXi home page appears, as shown in Figure 2-60.
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vmware ESXi’ ro0t@10.65.196.101 v | Help v | (Rl v
| 13 Navigator || B tocalhostlocaldomain
A ~
) (1)) GetvCenter Server | 31 Create/Register VM | Shutdown [ Reboot | (G Refresh | 4 Actions cry FREE: 18 ‘”3*“
Monitor localhost.localdomain USED: 241 GHz CAPACITY: 44 GHz
Version: 6.7.0 (Buikd §214924) J— J—
» (51 Virtual Machines State: Nommal (not connected to any vCenter Server) 5
& storage Uptime: 2376 days USED:60.0 63 CAPACITY: 118.87 GB
@ Networking STORAGE Fres a0 08
USED: 45178 CAPACITY: 5.44 T8
@ You are running Lenovo Customized Image ESXi6.5 (based on ESXi 6.5 Vmkenel Release Build 5146846)
~ Hardware ~ Configuration
Manufacturer Supermicro Image profile (Updated) HPE-ESXi-6.7.0-OS-Release-iso-
Gengplus-670.10.2.0.35 (Lenovo)
Model XIDRI-LN4+/XIDR3-LN4+
vSphere HA state Agent running
» [ cPU 20 CPUs x Intel(R) Xeon(R) CPU E5-2660 v
2@ 2.20GHz » vMotion Supported
K Memor 119.97 GB
" ~ System Information
[ rees=miiznmy 08 Dateftime on host Friday, November 01, 2019, 03:11:19 UTC
> (g Virtual f
@ Virtual fash 0B used, 0B capacity Install date Friday, June 28, 2019, 10:40:42 UTC
~ @ Networking Asset tag To Be Filled By O.E.M.
Hostname localhost localdomain e — [y— v
[¥] Recent tasks. =
Task | Target ~ | Initiator v Queued | Started v Resulta v Completedv v

Step 2 On the home page, click Create/Register VM.

Step 3 On the Select creation type page, select Create a new virtual machine and click Next.

Figure 2-61 Selecting a creation type

#31 New virtual machine

v (XTI Select creation type

2 Selecta name and guest 0S How would you like to create a Virtual Machine?
3 Select storage

4 Customize settings Create a new virtual machine This option guides you through creating a new virtual

5 Ready to complete Deploy a virtual machine from an OVF or OVA file machine. You will be able to customize processors, memory,

Register an existing virtual machine network connections, and storage. You will need to install a
guest operating system after creation.

Back Next Finish Cancel
4

Step 4 On the Select a name and guest OS page, specify the name, compatible VM, guest OS
family, and guest OS version, and then click Next.
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Figure 2-62 Specifying a name and guest OS

%31 New virtual machine - nsfocus-product (ESXi 6.7 virtual machine)

v 1 Select creation type
3 Select storage
4 Customize settings
5 Ready to complete

Select a name and guest OS

Specify a unique name and OS

Name

X

Virtual machine names can contain up to 80 characters and they must be unique within each ESXi instance.

[ nsfocus-product

Identifying the guest operating system here allows the wizard to provide the appropriate defaults for the operating system
installation.

Compatibility ESXi 6.7 virtual machine v
Guest OS family Linux v
Guest OS version Other Linux (64-bit) v
Back ‘ | Next Finish Cancel
. 4

Step 5 On the Select storage page, click Standard, select datastorel, and click Next.

Figure 2-63 Selecting a storage

%31 New virtual machine - nsfocus-product (ESXi 6.7 virtual machine)
¥ 1 Select creation type Select storage A
v 2 Selecta name and guest 0S Select the storage type and datastore
0 soectsore |
4 Customize settings S —
5 Ready to complete ——— 7
Select a datastore for the virtual machine's configuration files and all of its’ virtual disks.
Name ~ | Capacity v  Free v | Type v Thinpro..v | Access v
datastore1 54478 958.6 GB VMFS6 Supported Single v
1items.
Back || Next Finish Cancel
— A
Step 6 On the Customize settings page, configure virtual hardware parameters according to the
minimum configuration requirements listed in Table 2-1.
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Figure 2-64 Customizing settings

%31 New virtual machine - nsfocus-product (ESXi 6.7 virtual machine)
¥ 1 Select creation type Customize settings
V' 2 Selecta name and guest 0S Configure the virtual machine hardware and virtual machine additional options
v 3 Select storage
,
oo ConTEt [ Virtual Hardware | VM Options ‘
=2 Add hard disk =M Add network adapter ; Add other device
» [l crPu ~
4 AN i ]
» (2 Hard disk 1 GB v
» SCSI Controlier 0 LSI Logic Paraliel v
USB controller 1 USB 20 v
DL REmei =L ) VM Network v [ Connect
Pl G AT VM Network v | & Connect
RENPICDIVBIDIG Datastore ISO file v
Status M connect at power on
CD/DVD Media | | | Browse... |
Controller location IDE controller 0 v || Master v v
Back ‘ | Next Finish Cancel
Step 7 Mount the vRSAS image file.
a. Inthe Customize settings pane, select Datastore ISO file for CD/DVD Drive 1.
The Datastore browser page appears, as shown in Figure 2-65.
Figure 2-65 Datastore browser page
{3 Datastore browser
€ Upload [% Download [5 Delete |4 Move [ Copy {7 Create directory | (@ Refresh
datastore1 —
n )
#7 vmimages o
nsfocus-product.iso
| |
v
1 Il Il
B [datastore1] nsfocus-product.iso
Select || Cancel
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b. Click Upload and, in the dialog box that appears, select the local vVRSAS image file.

The upload progress is displayed in the upper-right corner of the page, as shown in
Figure 2-66.

After the upload is complete, the icon of the image file is displayed, as shown in Figure
2-67.

Figure 2-66 Upload progress displayed

{3 Datastore browser

@ Upload 7 Create directory | (3 Refresh 1 file(s) |

= datastore1
R

~1 vmimages

B3 [datastore1]

Select Cancel

Figure 2-67 Upload completed

{3 Datastore browser

@ Upload [% Download [5} Delete [ Move [ Copy {7 Create directory @ Refresh

datastore1
A

-
7 vmimages y

nsfocus-product.iso

@ nsfocus-product.iso

<

1l

B [datastore1] nsfocus-product.iso

Select || Cancel
A

Step 8 Select the image file, click Select to return to the Customize settings page, and click Next.
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Step 9 On the Ready to complete page, click Finish.

Figure 2-68 VM created for vVRSAS

v 1 Select creation type

v 2 Select a name and guest OS
v 3 Select storage

v 4 Customize settings

R4 5 Ready to complete

#31 New virtual machine - nsfocus-product (ESXi 6.7 virtual machine)

Ready to complete A
Review your settings selection before finishing the wizard
Name nsfocus-product
Datastore datastore1
Guest OS name Other Linux (64-bit)
Compatibility ESXi 6.7 virtual machine
VvCPUs 4
Memory 4GB
Network adapters 2
Network adapter 1 network VM Network
Network adapter 1 type £1000
Network adapter 2 network VM Network
Network adapter 2 type £1000
IDE controller 0 IDEO
IDE controller 1 IDE 1
SCSiI controller 0 LSI Logic Parallel
Hard disk 1
Capacity 200GB
Datastore [datastore1] nsfocus-product/
Mode Dependent v
Thicl 1nzili zon
Back Next Finish || Cancel

—End

Installing the Image File of vRSAS

To install the image file of vVRSAS, follow these steps:

Step1 Log in to the ESXi platform.

The ESXi home page appears, as shown in Figure 2-60.

Step 2 Choose VRSAS (nsfocus-product in this document) from the left navigation tree, as shown in

Figure 2-69.
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Figure 2-69 Selecting VRSAS to be installed

vmware ESXi 100l@10.65.196.101 v | Help ~ Q Search
Navigator (1 nsfocus-product
~ [ Host
@ | b Poweron / Edit | @ Refresh | 4% Actions A
Manage
Monitor nsfocus-product S
Guest OS Other Linux (64-bit) ot a
~ (31 Virtual Machines Compatibility ESXi 6.7 and later (VM version 14) W

VMware Tools No MEMORY EHEE
nsfocus-product -
crus . 08

Monitor

Memory 4GB storsce [
200 GB
@ VMware Tools is not installed in this virtual machine. VMware Tools allows detailed guest information to be displayed as well as allowing you to perform
B storage operations on the guest OS, e.g. graceful shutdown, reboot, etc. You should install VMware Tools. #§ Actions
@ Networking
~ General Information ~ Hardware Configuration
» @ Networking No network information » [ cPU 4VCPUs
» &8 VMware Tools Not installed 4§ Actions W \Memory 4GB
» B3 storage 1 disk » 22 Hard disk 1 200 GB
[= Notes / Editnotes USB controller uUsB 20
» B Network adapter 1 VM Network (Connected)
» BH Network adapter 2 VM Network (Connected)
» [@ video card 4MB
» (&) CDIDVD drive 1 1SO [datastore1] nsfocus-productiso v
3 Select disc image

7] Recent tasks

Task v Target v Initiator v Queued v Started v Result a v Completed v v
Find By Inventory Pstn None oot 012019 112625 1101201911:2825 | () Completed succe: 1012010 11:28:25
Uplos e to datssiore dstasioret ot 012010 112449 | 1012019112640 | () Completed succe: 112010 11:28:22
Revert To Snspshot 2) RSAS_FOI_NEW-ga(... | root 012019 112615 1101201911:2615 | Q) Compieted succe: 1012010 11:24:18
Copy Datsstore Fie None oot 012010 11240 1012019112348 | Q) Completed succe: 1012010 112348
Creste M 2 oot 012019 113438 1012019113438 | Q) Completed successully 1012010 11:34:40

Step 3 In the right pane, click Power on.

Figure 2-70 Console

NSFOCUS RSAS installer boot menu

[ Jnstall

fdvanced options >

—

7 NSFOCUS

Step 4 Install VRSAS.

Copyright © NSFOCUS 66 V6.0R04F04



z =

»,—;'-;:‘« NSFOCUS NSFOCUS RSAS Installation Guide

The procedure of installing VRSAS on the ESXi platform is the same as that for the VMware
Workstation platform described in Installing the Image File of vVRSAS.

Step 5 Add a network adapter.

vRSAS only provides one network interface (that is, management interface) by default.
Perform the following steps to add a network adapter to enable the scan interface.

a. Choose VRSAS from the left navigation tree, as shown in Figure 2-69.
Click Edit.
The Edit settings dialog box appears.

c. Click Add network adapter to add Network Adapter 2.

Figure 2-71 Adding a network adapter

() Edit settings - nsfocus-product (ESXi 6.7 virtual machine)

Virtual Hardware VM Options

2 Add hard disk | =W Add network adapter | (= Add other device A
» [ cPU 4 v | O
W
» @l Memory 4096 MB v
» &3 Hard disk 1 120 GB v
» K3 SCSi Controlier 0 LSI Logic Parallel v
USB controller 1 SB 2 v
» M Network Adapter 1 VM Network v ] Connect
» ®H Network Adapter 2 VM Network v ] Connect
» =y CD/DVD Drive 1 Datastore 1SO file v | V] Connect
v
» [H video Card Qnarifu rrictam caftinne v
Save || Cancel

d.  On the page shown in Figure 2-72, configure the mode of Network Adapter 2 as required,
and select the Connect check box in the right pane.
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Figure 2-72 Configuring the network adapter 2

» [ video Card

(5] Edit settings - nsfocus-product (ESXi 6.7 virtual machine)

Virtual Hardware VM Options

2 Add hard disk ®m Add network adapter (=} Add other device A
» [ cPU s v @
» @l Memory v4095 MB v
» (2 Hard disk 1 Bon | (a8 v
» SCSI Controller 0 LSI Logic Parallel v
USB controller 1 520 v
» ™ Network Adapter 1 VM Network v [/ Connect
» ®H Network Adapter 2 VM Network v [/ Connect
> = CD/DVD Drive 1 Datastore ISO file v | vl Connect

[ e -

Save Cancel

e. Click Save.

f.  (Optional) Add other network adapters as required.

—End

Performing Initial Configuration

For how to perform initial configuration, see Performing Initial Configuration.

Conducting License-based Authentication

Mounting the Dongle

A

Caution

Do not remove the dongle when VRSAS is in use. Otherwise, VRSAS would
automatically exit.

To mount the dongle, follow these steps:

Step 1 Insert the dongle in the VMware vSphere ESXi server.

Step 2 Log in to the ESXi platform.

The ESXi home page appears, as shown in Figure 2-60.

Step 3 Choose VRSAS from the left navigation tree, as shown in Figure 2-69.
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Step 4 Click Edit.

The Edit settings page appears, as shown in Figure 2-73.

Figure 2-73 Editing settings

(<1 Edit settings - nsfocus-product (ESXi 6.7 virtual machine)

[ Virtual Hardware | VM Options |

2 Add hard disk ®m Add network adapter (=] Add other device A
» [ cPu . v @
» 98 Memory 4096 MB v

» 2 Hard disk 1 cB v

» SCSI Controller 0

LS| Logic Parallel v
USB controller 1 USE 2.0 v
» ®H Network Adapter 1 VM Network v | [/] Connect
» EH Network Adapter 2 VM Network v [/ Connect
> @ CD/DVD Drive 1 Datastore ISO file v | k] Connect
v
» [ video Card Crnnifus rriobnm enbinne v
Save || Cancel
- b
Step 5 On the Edit settings page, click Add other device and choose USB device.
Figure 2-74 Adding a USB device
(<1 Edit settings - nsfocus-product (ESXi 6.7 virtual machine)
[ Virtual Hardware | VM Options |
2 Add hard disk M Add network adapter | (= Add other device A
» [ cPU 4 ) CD/DVD drive
Floppy drive
> @l Memory 400
E@ Seral port
> &= Hard disk 1 200/ [@ Parallel port
» B SCSI Controller 0 L& USB controller v
=a USB device
USB controller 1 S -
3 ® Soundd USB device
» EH Network Adapter 1 VM v V] Connect
> M Network Adapter 2 VM SCsl controller v | [ Connect
> & CD/DVD Drive 1 Datastore ISO file v M Connect
v
» [ video Card Crunnifs mrietnem crHinne v
Save || Cancel
_— L=

Copyright © NSFOCUS 69 V6.0R04F04



-

Step 6

—="-NSFOCUS NSFOCUS RSAS Installation Guide

On the Edit settings page, select Philips Elite4 5.x as the new USB device and click Save.

Figure 2-75 Saving the dongle configuration

(3] Edit settings - nsfocus-product (ESXi 6.7 virtual machine)

[ Virtual Hardware | vM Options |

2 Add hard disk ®m Add network adapter (=] Add other device

» [ crPu

4 v (7]
» 3R Memory 4096 MB v

» [ Hard disk 1

200 GB v

» 3 SCsI Controller 0 LS Logic Parallel v

USB controlier 1 USB 2.0 v
» EH Network Adapter 1 VM Network v | V] Connect
» =H Network Adapter 2 VM Network v ] Connect
> & CD/DVD Drive 1 Datastore 1SO file v M Connect
» [E Video Card Specify custom settings v

850 New USB device Philips Elited 5.x v

Save || Cancel
> JL = ]

—End

Importing a License

For how to import a license, see Importing a License.

2.2.4.3 Uninstallation Procedure

Step1

Step 2
Step 3
Step 4

To delete VRSAS from the ESXi platform, follow these steps:

Log in to the ESXi platform.

The ESXi home page appears, as shown in Figure 2-60.

Choose VRSAS from the left navigation tree, as shown in Figure 2-69.
Click Power off to shut down RSAS.

Choose Actions > Delete.

VRSAS is then completely removed from the datastore.

—End

2.2.5 Installation on FusionCompute

This section describes how to install VRSAS on FusionCompute.

Copyright © NSFOCUS 70 V6.0R04F04



Z="NSFOCUS

2.2.5.1 Preparations

NSFOCUS RSAS Installation Guide

Table 2-5 lists preparations to be made for installing vVRSAS on FusionCompute.

Table 2-5 Preparations to be made for installing VRSAS on the FusionCompute platform

Item Description
FusionCompute | IP address IP address of a computer that can properly connect to the network.
e Account Account with privileges of a system administrator.
vRSAS CD Contains an image file (.iso) of VRSAS.
IP address IP address of the scan interface of vVRSAS.
?uthentication License that enables VRSAS to be launched properly.
icense

Unique authorization hash value granted to vRSAS.

IP address of a CAA platform and license of vVRSAS.

License of vVRSAS for authentication by NSFOCUS security
cloud.

Dongle and license: The dongle should be already installed on
the FusionCompute server.

A\ Y

Note

You can select any one of the three authentication modes.

2.2.5.2 Installation Procedure

Obtaining the Image File of vRSAS

For how to obtain the image file of VRSAS, see Obtaining the Image File of vVRSAS.

Creating a VM

To create a VM, follow these steps:

Step1 Log in to the FusionCompute platform.

The FusionCompute home page appears, as shown in Figure 2-76.
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Figure 2-76 Home page of FusionCompute

VM and Template ~ Computing Pool  Storage Pool ~ Network Pool  Monitoring

iome

Resource Statistics

Resource Configuration

=)

9
o mputing P B\ siorag
1% -] o
g | Hos & | Datast & |ovs
10 20 10

VM Status Host Status Others
Total 9 Total 1
...O Cluster
Running 4 44.4% Running 1 100.0% °0 1
Stopped 5 55.6% Powered off 0 0.0%
Faulty 0 0.0% Faulty 0 0.0%
®  Port Group
D Others 0 0.0% D Others 0 0.0% oy

System

g Zala Store 5 ;o(()a\ Disk

& ovs

Common Operations

Step 2 Choose VM and Template.

Figure 2-77 VM and Template page

Compute [ neraname, 1P adaress, dscrpton orvM IDtoseaeh 0

104 @0 @1 2admin -

System

Computing Pool  Storage Pool  Network Pool  Monitoring
1] Getting Started i
ow
£3 Template and Specifications The VM and Template page allows you to create, perform operations on, and manage VMs and VM templates.
© Recently Viewed VMs
aD Create VM Drn“l Import VM
nr+ alle —¢=  template that s stored ot o

Create VM mport VM

Import Template

Y
4

mport Template

Explore Further
What is a VM?

Step 3 Click Create VM.
The Create VM page appears, as shown in Figure 2-78.
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Figure 2-78 Create VM page

Compute [ rtera name, @ aress, descripbon or M Dtosearh 0 104 @0

Computing Pool Storage Pool Network Pool Monitoring System

Name Description

ManagementCluster

4] Advanced Settings (Optional)

Next Cancel

Step 4 Specify a location for the VM and click Next.
Step 5 On the Properties page, configure parameters and click Next.

e  Select Others for OS and Other(32 bit) for OS Version.

®  Specify the size of memory and the number of CPUs according to the minimum
configuration requirements listed in Table 2-1. Select 1 for Number of disks.
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Location Properties Set

VM name nsfocus-product
0s Others
OS Version Other(32 bit) ~|
OS Name
Hardware

cPU 4 ] @

Number of cores per socket: 4 w Sockets: 1

Memory 4 GB

Number of disks: 1 T

Number of NICs 4 |

QoS Settings
Description:
HA: Enable (7]
Clock sync: Sync time with host @
Policy for handling blue |
screen of death for a VM No processil
Boot device Hard disk
VNC Keyboard Settings: English (US ~|
Disable (7]
4| Advanced Settings (Optional)
Previous Next Cancel

Step 6 On the VM Settings page, configure network interface cards (NICs) and disk parameters, and
then click Next.
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Figure 2-80 VM Settings page

Compute [ rter a name, P acdress, descrpton o WD tosearch Q] 10400 2 admin -

Computing Pool Storage Pool Network Pool Monitoring ~ System ?-
Create VM
Location Properties VM Settings
NIC Settings @
NIC1 NIC2 NIC3
Port Group: | managePortarc Port Group: | managePortgrc Port Group: | managePortgr¢
NIC4

* Port Group: | managePortgrc

Disk Settings
Disks1
* Data Store: | autoDS01 C * Capacity (GB): | 20 (2]
) (2}
(2}
Previous Next Cancel

Step 7 On the Confirm page, confirm that all information is correct and click Finish.

Figure 2-81 Confirm page

Create VIV
Location Properties VM Settings Confirm
Location
ManagementCluster
Properties
nsfocus-product Other Other(32 bit)
4(Reserved (MHz): 4 1 4(Reserved (MB):2
Enabled Sync time with host Noprocessing Memory hot add:
English (US) Hard disk
Enabled Automatic N ) HW_X_NET
Disabled Disabled BIOS
VM Settings
NIC:
NICT (OVs DVS Port Group group)
NIC2 (OVs DVS Port Group group)
NIC3: (DV DVS,Port Group: group)
NIC4: () DV, Port Group: group)
Disk
Disk1 (Data Store:autoDS01,Configuration mode:Common,Capacity (GB):20,Persistent:Taken into snapshots.)
Start the VM after creation
Previous Finish Cancel

—End
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Installing the Image File of vVRSAS

To install the image file of vVRSAS, follow these steps:

Step1 Log in to the FusionCompute platform.
The FusionCompute home page appears, as shown in Figure 2-76.

Step 2 Choose VM and Template.

Step 3 On the page shown in Figure 2-77, choose VM from the left navigation tree.
The VM list appears, as shown in Figure 2-82.

Figure 2-82 VM list

Compute [ rteraname, 1P agcress, descripton or VM Do search- 0] 10t @0

Computing Pool Storage Pool Network Pool ~ Monitoring ~ System

18] Getting Started
= Vi)

£3 Template and Specifications Export Al statuses Al types Name ~|E O| Advanced Search D £
O Recently Viewed VMs

Name D Status Type CPU Usage Memory Usage  IP Address Cluster Host Operation

nsfocus-product -00000053  Stopped Common VM - - 0.0.0.0,0.0.0.0{ ManagementC

Running Common VM 0.00% 0.00% 0.0.0.0,0.0.00 M:

Stopped Common VM - - 00000000 M:

Running Common VM 000% | 0.00% | 0.0.00,0000 M
i-0000004C  Running Common VM 000% | [ 000% | 00000000 Manag
i-0000004A  Stopped Common VM - - 00000000 M

00000049 Stopped Common VM - - 0.00.0,0000 ManagementC

Stopped Common VM - - 00000000 M:

i0000000C  Stopped Common VM - - 00000000 M

100000001  Running Common VM 000% | [QMSG@D% | 10.65.197.101f M

20 Displaying 1 - 10 of 10 D Goto Page )

Step 4 On the line of VRSAS, click Start in the Operation column. In the dialog box that appears,
click OK.

Step 5 Log in to the console.

a.  On the line of VRSAS, click Log in Using VNC in the Operation column.
b. In the dialog box that appears, click noVNC.
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Figure 2-83 Selecting a VNC-based login method

NSFOCUS RSAS Installation Guide

Information

Setthe default VNC login mode. You can
choose System = System Configuration = VNC
Login to change the default mode.

noVNC TightVNC

Figure 2-84 Page appearing after successful login

@ 100000053 [0.0.0.0] nsfocus-product - Mozilla Firefox

@ https://10.65.197.101:9876/vnc_auto html?vmID==i-00000053==5C650A88==en_US==E9D385907527C8S!

DO7DDAB14C47CE3DE==https:

Ctrl-Alt-Del

)6.0 CAOO PCIZ.10 PnP PMM DFFD1AEO DFF91AEG CAOO

iPXE v1.0.0-5
iPXE (http://ipxe.org

from CDROM (code 0003)

Step 6 Mount a CD/DVD-ROM drive.

:07.0 CBOO PCIZ.10 PnP PMM DFFD1AE® DFF91AEG CBOO

a.  In the window shown in Figure 2-77, click CD/DVD-ROM Management.

A page appears, as shown in Figure 2-85.
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Figure 2-85 Mounting a CD/DVD-ROM drive

@ CD/DVD-ROM Management._-00000053 - Mozilla Firefox oo )=

[l Whttps://10.65.197.101/OmsPortal/portal/controller/businessfvmandtemplate fvmLogin_htm|S.html?params=i-00000053=5C650A88|

Infarmation:
1.¥When mounting a local CD/DVD-ROM drive, do not close or refresh the current page. Otherwise, the CDIDVD-ROM drive will fail to mount
2. During the Linux OS installation, if the WM has started from the hard disk, forcibly restart the Wi,
For mare information, please click@

Mount Local CD/DVYD-ROM Drive

Mount Shared CD/DVYD-ROM Drive

Unmount CD/DVYD-ROM Drive

b. Click Mount Local CD/DVD-ROM Drive.
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Figure 2-86 Selecting the VRSAS image file to be mounted

@ CD/DVD-ROM Management_i-00000053 - Mozilla Firefox ol a =

[ “Whttps://10.65.197.101/OmsPortal/portal/controller/business/vmandternplate frLogin_html5.htrml?params=i-00000053=5C650488

Information:
1. When mounting a local CDIDVD-ROM drive, do not close or refresh the current page. Otherwise, the CD/DVD-ROM drive will fail to mount.
2. During the Linux OS installation, if the ¥M has started from the hard disk, forcibly restart the V.
For more infarmation, please click@

(@ CD/DVD-ROM:
J: :
) File{*.iso):
Browse
(0 Device path:

Browse

[_] Restart the ¥M now to install the 0S.

Confirm Cancel

c.  Click File and browse to the local vVRSAS image file. Select Restart the VM now to
install the OS and click Confirm.

Copyright © NSFOCUS 79 V6.0R04F04



z =

#,"i':f« NSFOCUS NSFOCUS RSAS Installation Guide

Figure 2-87 Starting VRSAS

@ CD/DVD-ROM Management._i-00000053 - Mozilla Firefox oo ==

| P “Whttps://10.65.197.101/OmsPortal/portal/controller/businessfirmandtemplatefvmLogin_htm|5.html?params=i-00000053=5C650488

Information:
1. ¥When mounting a local CD/DVD-ROM drive, do not close or refresh the current page. Otherwise, the CD/IDVD-ROM drive will fail to mount.
2. During the Linux OS installation, ifthe ¥M has started from the hard disk, forcibly restart the Wi,
For more information, please click@

() CD/DVD-ROM:
@) File(*.iso):

IAnsfocusinsfocus-productiso Browse
(0 Device path:

Browse

Restart the VM now to install the 0S.

Confirm Cancel

Step 7 Install vRSAS.

The procedure of installing VRSAS on the FusionCompute platform is the same as that for the
VMware Workstation platform described in Installing the Image File of VRSAS.

Step 8 Add a network adapter.

vRSAS only provides one network interface (that is, management interface) by default.
Perform the following steps to add a network adapter to enable the scan interface.

a. Choose VM and Template.
b. Choose Recently Viewed VMs > RSAS > Hardware.
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Figure 2-88 Hardware page
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CD/DVD-ROM drive on a clientunmounted)

Summary Hardware Options Snapshot Monitoring  Task Tracing — Alarm Event
CPUs
: CPUs
& oo
5 1, Total space 20 GB
=H
Number of cores 4
[ 0 Number of cores per socket: | 4
n CPU Resource Control
¥ Available Quota Medium
g Resenved (MHy): | ——
20

ES

No limit

# Limited by host CPU usage

CPU Advanced Seftings

Available CPUs:

0K

Sockets: 1

@

0 2

On the Hardware page, choose NICs from the left pane.

Configure the NIC parameters and click OK.

c.
d. Click Add.
e
f.

(Optional) Add other network adapters as required.

—End

Performing Initial Configuration

For how to perform initial configuration after login to vVRSAS (as detailed in Installing the
Image File of VRSAS), see Performing Initial Configuration.

Conducting License-based Authentication

Mounting the Dongle

A

Caution

Do not remove the dongle when VRSAS is in use. Otherwise, VRSAS would
automatically exit.
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To mount the dongle, follow these steps:
Step 1 Insert the dongle in the FusionCompute server.
Step 2 Log in to the FusionCompute platform.
The FusionCompute home page appears, as shown in Figure 2-76.
Step 3 Choose VM and Template.
Step 4 On the page shown in Figure 2-77, choose Recently Viewed VMs > RSAS > Hardware.
Step 5 On the Hardware page, choose USB devices from the left pane.

Figure 2-89 USB device page

Summary Hardware Options Snapshot Monitoring  Task Tracing — Alarm Event

CPU
P CPUS >}
& oo
5 1, Total space 20 GB
:
Number of cores: 4
l i} Number of cores per socket: | 4 Sockets: 1
n i CPU Resource Control
= | (D Quota Medium 4 (2]
ﬂ Resenved (MH7): | —— | )
=0
E
CD/DVD-ROM drive on a clientunmounted)
No limit

# Limited by host CPU usage

CPU Advanced Settings

Available CPUs:

oK

Step 6 Click Attach USB device.
Step 7 In the Attach USB Device dialog box, select Philips Elite4 2.x and click OK.
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Figure 2-90 Attaching a USB device

NSFOCUS RSAS Installation Guide

Attach USE Device
Controller Type: EHCI+UHCI{Supports USB2.0 and USB1.1 devices)
Select host: -
USB ID Product ID Host Description
163_1_1p4 4858 Elited 2.x. Senselock
15 Displaying 1 -1 of 1 Ft ‘ ‘ Fage Goto Page )
-—End

Importing a License

For how to import a license, see Importing a License.

2.2.5.3 Uninstallation Procedure

Step1
Step 2
Step 3

Step 4
Step 5

To delete VRSAS from the FusionCompute platform, follow these steps:

Log in to the FusionCompute platform.

Choose VM and Template.

On the page shown in Figure 2-77, choose VM from the left navigation tree.

The VM list appears, as shown in Figure 2-82.

On the line of VRSAS, click More > Safely delete in the Operation column.

In the dialog box that appears, select a time to delete VRSAS and then click OK.

VRSAS is then completely removed from the datastore.
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Figure 2-91 Confirming the deletion

Infarmation

Delete now

Delete in

oK

Are you sure you want to delete it?

hours

Cancel

—End

2.2.6 Installation on KVM

This section describes how to install VRSAS on a standard KVM platform.

2.2.6.1 Preparations

Table 2-6 lists preparations to be made for installing vRSAS on KVM.

Table 2-6 Preparations to be made for installing VRSAS on the KVM platform

Item Description
KVM server IP address IP address of a computer that can properly connect to the network.
(standard Account Account with privileges of a system administrator.
platform)
Bridge NIC Run the following sample command to create a bridge NIC. The
created bridge NIC is as shown in Figure 2-92.
virsh iface-bridge --interface ensl92 --bridge br0
#ensl192 indicates the name of a physical NIC for
bridging; br0 indicates the name of a bridge NIC
vRSAS CD Contains an image file (.iso or .qcow2) of vVRSAS.
IP address IP address of the scan interface of vVRSAS.
Authentication | +  License that enables vVRSAS to be launched properly.
license

*  Unique authorization hash value granted to vRSAS.

* [P address of a CAA platform and license of VRSAS.

* License of VRSAS for authentication by NSFOCUS security
cloud.

* Dongle and license: The dongle should be already installed on the
KVM server.
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Item Description
N,
Note
You can select any one of the three authentication modes.

Figure 2-92 Creating the bridge NIC successfully

[root@localhost ~]# brctl show

bridge name bridge id STP enabled interfaces
(bro 8000.000c29488e4c yes ens192]
virbro0 8000.5254000ab3d5 yes virbrO-nic

[root@localhost ~]#

2.2.6.2 Installation Procedure

This document takes rsas as an example to describe how to install vVRSAS by using command
lines.

Installing an ISO Image File

If the disk space is greater than 150 GB, use the single-disk installation. Otherwise, mount a
second disk with more than150 GB space and use the dual-disk installation

Single-Disk Installation

If the disk space is greater than 150 GB, install VRASA in one disk.
Step1 Create a disk file that is greater than 150 GB, for example, 160 GB.

gemu-img create -f gcow2 /kvm/images/rsas.qgcow2 160G
Step 2 Create a VM, as shown in Figure 2-93.

virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-
V6.0R04F00-37872.1is0 —--disk /kvm/images/rsas.gcow?2, format=gcow2,size=160 --vnc --
vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

#H##

--name: indicates the VM name.

—-ram: indicates the memory.

--vcpus: indicates the number of CPU core.

--cdrom: indicates the absolute path of the VvRSAS image file.

--vnc: indicates the listening port and listening address for Virtual Network
Console (VNC) .
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Step 3

Step 4

Step1

Figure 2-93 Creating a VM

root@kvm—debian: # virt-install -—name rsas ——ram 8192 ——vcpus 4 ——cdrom=/iso_store/RSAS-VH-V6. ORO4F0O0—
37872.is0 ——disk /kvm/images/rsas. qcow?, format=qcowZ, size=160 ——vnc ——wncport=5910 ——mnclisten=0.0.0.0 —
network bridge=br0 --os—type=linux

Starting install...
Creating domain... | 0B
00:00:00

(virt-viewer:24096) : Gtk-WARNING **: cannot open display: localhost:11.0
Domain installation still in progress. You can reconnect to

the console to complete the installation process.

Iroot@lwm-deb'1an: #

Install vRSAS by using VNC, as shown in Figure 2-94.

Type IP:PORT in the address bar to connect VNC Viewer, where IP is the IP address of the
Linux host of vRSAS, and PORT is 5910 specified during the creation of VM.

Figure 2-94 Connecting to VNC

V2]

connecr 10.6 7:5910

& 106 5910 (QEMU (rsas6030)) - VNC Viewer - (] X

106 7:591¢

NSFOCUS Product installer boot menu

muvanced options >

Install the vRSAS image file.

The procedure of installing VRSAS on VNC is the same as that for the VMware Workstation
platform described in Installing the Image File of vRSAS.

—End

Two-Disk Installation

If the disk space is less than 150 GB, mount a second disk with a capacity of greater than 150
GB, and install vVRSAS with dual disks.

Create a code disk that is greater than 4 GB, for example, 8 GB, as shown in Figure 2-95.

gemu-img create -f gcow2 /kvm/images/rsas-code.qgcow2 8G
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Figure 2-95 Creating a code disk

[root@localhost rsas]# qemu-img create -f qcow2 /kvm/images/rsas-code.qcow2 8G

Formatting '/kvm/images/rsas-code.qcow2', fmt=qcow2 size=8589934592 encryption=off cluster_size=65536 lazy_refcounts=o
ff

[root@localhost rsas]#

Step 2 Create a VM, as shown in Figure 2-96.

virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-
V6.0R04F00-37872.1is0 —--disk /kvm/images/rsas-code.gcow?2, format=gcow2,size=8 --vnc -

-vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

(3di

--name: indicates the VM name

—--ram: indicates the memory

--vcpus: indicates the number of CPU cores

--cdrom: indicates the absolute path of the VvRSAS image file
--vnc: indicates the listening port and listening address for VNC

Figure 2-96 Creating a VM

root@kvm-debian:~# virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-V6.0R04F00-37872.iso --disk
/kvm/images/rsas-code.qcow?2,format=qcow?,size=8 --vnc --vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

Starting install...
Creating domain... | 0B 00:00:00

(virt-viewer:9098): Gtk-WARNING **: cannot open display: localhost:11.0
Domain installation still in progress. You can reconnect to

the console to complete the installation process.

root@kvm-debian:~#

Step 3 Install VRSAS by using VNC, as shown in Figure 2-97.

Type IP:PORT in the address bar to connect VNC Viewer, where IP is the IP address of the
Linux host of vRSAS, and PORT is 5910 specified during the creation of VM.

Figure 2-97 Installing vRSAS using VNC

VeI 1:5910 (QEMU (rsas)) - VNC Viewer

NSFOCUS Product installer boot menu

[ Jinstall

sdvanced options >

Step 4 Install the vRSAS image file.
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The procedure of installing VRSAS on VNC is the same as that for the VMware Workstation
platform described in Installing the Image File of vRSAS.

Step 5 Create a data disk in a custom path, as shown in Figure 2-98.

gemu-img create -f gcow2 /kvm/images/rsas-data.gcow2 160G

Figure 2-98 Creating a data disk

[root@localhost ~]# qemu-img create -f qcow2 /kvm/images/rsas-data.qcow2 160G

Formatting '/kvm/images/rsas-data.qcow2', fmt=qcow2 size=171798691840 encryption=off cluster_size=65536 lazy_refcounts
=off

[root@localhost ~]#

Step 6 Mount the data disk to vVRSAS.

a.  After vVRSAS is installed, it is shut down. In this status, run the following command to
confirm that the code disk ID is hda, as shown in Figure 2-99.

virsh dumpxml rsas

Figure 2-99 Querying the ID of the code disk

[root@localhost ~]# virsh dumpxml rsas
<domain type="kvm' id='9'>
<name>rsas</name>
<uuid>f79ff54a-4cch-47a5-c71f-bf938812995f</uuid>
<memory unit="KiB'>8388608</memory>
<currentMemory unit='KiB'>8388608</currentMemory:>
<vcpu placement="static'>4</vcpu>
<resource>
<partition>/machine</partition>
</resource>
<0S>
<type arch="x86_64" machine="pc-i440fx-rhel7.0.0"'>hvm</type>
<boot dev="cdrom'/>
<boot dev="hd'/>
</0s>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>destroy</on_reboot>
<on_crash>destroy</on_crash>
<devices>
<emulator>/usr/libexec/qemu-kvm</emulator>
<disk type='file' device="disk'>
<driver name='gemu' type='qcow2'/>
[<source fi1e='/kvm/images/rsas-code.qcowZ'/>]

<
<target dev="hda'| bus="1ide'/>

<alias name='1de0-0-0"/>
<address type='drive' controller='0" bus='0" target='0" unit="0"/>
</disk>

b. Mount the data disk, with an ID numbered sequentially based on the ID of the code disk
obtained in the previous step. For example, if the code disk is hda, the data disk must be
set to hdb, as shown in Figure 2-100.
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virsh attach-disk --domain rsas --subdriver gcow2 --source /kvm/images/rsas-
data.gcow2 --target hdb --persistent

(3di

--domain: indicates the name of VvRSAS.

—--source: indicates the source path of the disk to be installed.
--target: indicates the target disk added to the VM.

Figure 2-100 Adding a data disk

[root@localhost ~]# virsh attach-disk --domain rsas --subdriver qcow2 --source /kvm/images/rsas-data.qcow2 --target h
db --persistent

c.  After the configuration is complete, check the configuration files of VRSAS, which already
contains the data disk, as shown in Figure 2-101.

virsh dumpxml rsas

Figure 2-101 Checking the data disk configuration

[root@localhost ~]#{virsh dumpxm1 rsas]
<domain type="kvm'>
<name>rsas</name>
<uuid>f79ff54a-4cch-47a5-c71f-bf938812995f</uuid>
<memory unit="KiB'>8388608</memory>
<currentMemory unit='KiB'>8388608</currentMemory>
<vcpu placement="static'>4</vcpu>
<0s>
<type arch="x86_64"' machine="pc-i440fx-rhel7.0.0">hvm</type>
<boot dev="hd'/>
</0s>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>restart</on_reboot>
<on_crash>restart</on_crash>
<devices>
<emulators>/usr/Tibexec/qemu-kvm</emulator>
<disk type='file' device="disk'>
<driver name="qemu' type='qcow2'/>
<source file='/kvm/images/rsas-code.qcow2'/>
<target dev="hda' bus='ide'/>
<address type='drive' controller="0" bus='0
</disk>
<disk type='file' device="disk'>
<driver name="qemu' type='qcow2'/>
<source file='/kvm/images/rsas-data.qcow2'/>
<target dev="hdb' bus="ide'/>
<address type='drive' controller="0" bus='0"' target='0" unit="1"/>
</disk>

' target='0" unit="0"/>

Step 7 Start the VRSAS and wait until the installation is complete.
virsh start rsas

—End

Copyright © NSFOCUS 89 V6.0R04F04



=

- -NSFOCUS NSFOCUS RSAS Installation Guide

Installing a QCOW2 Image File

Single-Disk Installation

1. Create a single-disk image

You can perform the following steps to create a qcow?2 image file or obtain it from
NSFOCUS's after-sales personnel.

Step1 Create a disk file that is greater than 150 GB, for example, 160 GB.
gemu-img create -f gcow2 /kvm/images/rsas.gcow2 160G
Step 2 Create a VM, as shown in Figure 2-102.

virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-
V6.0R04F00-37872.1is0 —--disk /kvm/images/rsas.qgcow?2, format=gcow2,size=160 --vnc --
vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

#H##

--name: indicates the VM name.

—-ram: indicates the memory.

--vcpus: indicates the number of CPU cores.

--cdrom: indicates the absolute path of the VvRSAS image file.

--vnc: indicates the listening port and listening address for VNC.

Figure 2-102 Creating a VM

root@kvm-debian:~# virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-V6.0R04F00-37872.iso --disk
/kvm/images/rsas.qcow?2,format=qcow?2,size=160 --vnc --vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

Starting install...
Creating domain... | 0B 00:00:00

(virt-viewer:31080): Gtk-WARNING **: cannot open display: localhost:11.0
Domain installation still in progress. You can reconnect to

the console to complete the installation process.

root@kvm-debian:~#

g After the ISO installation is complete, the window shown in Figure 2-103 appears. Do
B not run the virsh start command to start the new VM. Otherwise, the image is
Caution automatically installed, and the qcow2 image cannot be created.
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Figure 2-103 VM created

Step 3 Check the path of the .qcow2 image file, as shown in Figure 2-104 or Figure 2-105.

Figure 2-104 Viewing the path of the disk image file visually

=y - ow [ &
E Overview K Virtual Disk
05 inf ti Source path: /kvm/images/rsas.qcow?2 |
g information Device type: TDE Disk T
Performance Storage size: Unknown
Q CPUs Readonly: [ |
Shareable: [_|
== Memory
% Boot Options » Advanced options
%) IDE CDROM 1
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Figure 2-105 Viewing the path of the disk image file by using commands

[root@localhost images]#[virsh dumpxm1 rsas]
<domain type="kvm' id="15">
<name>RSAS</name>
<uuid>d988c2d6-0f15-5032-116c-74807f6f906e</uuid>
<memory unit='KiB'>8388608</memory>
<currentMemory unit="KiB'>8388608</currentMemory>
<vcpu placement="static'>4</vcpu>
<resource>
<partition>/machine</partition>
</resource>
<0S>
<type arch="x86_64" machine="pc-i440fx-rhel7.0.0"'>hvm</type>
<boot dev="cdrom'/>
<boot dev="hd'/>
</0s>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>destroy</on_reboot>
<on_crash>destroy</on_crash>
<devices>
<emulator>/usr/libexec/qemu-kvm</emulator>
<disk type='file' device="disk'>
<driver name="gemu' type='qcow2'/>
(<source file="/kvm/images/rsas.qcow2’/> |
<backingStore/>
<target dev="hda' bus="ide'/>
<alias name="1ide0-0-0"/>
<address type='drive' controller='0" bus="'0" target='0" unit="0"/>
</d1.Sk>

Step 4 Compress the image file.

gemu-img convert -c -0 gcow2 /kvm/images/rsas.qcow2 /kvm/images/rsas-danpan.gcow?2
#rsas-danpan.qgcow?2: indicates a compressed .gcow2 image that is close to the size
of the ISO image.

-—-End
2. Install VRSAS in one disk
Step 1 Install VRSAS by using the single-disk qcow2 image, as shown in Figure 2-106.

virt-install --name rsas --ram 8192 --vcpus 4 --import --disk
path=/kvm/images/rsas-danpan.qgcow2 —--network bridge=br0 --vnc --vncport=5910 --
vnclisten=0.0.0.0 --os-type=linux

(3di

--name: indicates the VM name.

—-ram: indicates the memory.

--vcpus: indicates the number of CPU cores.

--disk: indicates the absolute path of the single-disk gcow2 image file.
--vnc: indicates the listening port and listening address for VNC.
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Figure 2-106 Using the single-disk qcow2 image

root@kvm-debian:~# virt-install --name rsas --ram 8192 --vcpus 4 --import --disk path=/kvm/images/rsas-danpan.qcow?2 --network
bridge=br0 --vnc --vncport=5910 --vnclisten=0.0.0.0 --os-type=linux

Starting install...
Creating domain... | 0B 00:00:00

(virt-viewer:7550): Gtk-WARNING **: cannot open display: localhost:11.0

Domain creation completed. You can restart your domain by running:
virsh --connect gemu:///system start rsas

root@kvm-debian:~#

Step 2 Connect to VRSAS by using VNC.

Type IP:PORT in the address bar to connect VNC Viewer, where IP is the IP address of the
Linux host of vRSAS, and PORT is 5910 specified during the creation of VM, as shown in
Figure 2-107.

Figure 2-107 Connecting to VRSAS via VNC

m 10.66 1:5910 (QEMU (rsas)) - VNC Viewer
Booting Systenm’

starting version 232
[ 31.8538881 shl476]1: Starting installing...Please wait patiently

Step 3 Wait until the installation is complete.
The console-based login page appears, as shown in Figure 2-108.

Figure 2-108 Installation completed

/ 71_7 I\ N/
/., _f___ 11 __

/7 7 1_1/ /7 7
Version 6.8
NSFOCUS Remote Secur ity Assessment System

Copyright (C) 1999-2628

NSFOCUS Corporation, A1l rights Reserved

http://vww.nsfocus.com.cn

IVl __ 1111 __ NI ____ 11171
I W IN_ N1 INNNIN /177N
77 7 771 1 1771117 /7.7 7

I 7 \_11____11 1 \____/\ IN___ 717

Helcome to use RSAS at Tue Feb 14 2823 68:18:18

RSAS login:
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—End

Dual-Disk Installation

1. Create a dual-disk image

You can perform the following steps to create a qcow?2 image file or obtain it from
NSFOCUS's after-sales personnel.

If the disk space is less than 150 GB, mount a second disk with a capacity of more than
150 GB, and install VRSAS with dual disks.

Step1 Create a code disk that is greater than 4 GB, for example, 8 GB, as shown in Figure 2-1009.

gemu-img create -f gcow2 /kvm/images/rsas-code.qgcow2 8G

Figure 2-109 Creating a code disk

[root@localhost rsas]# qemu-img create -f qcow2 /kvm/images/rsas-code.qcow2 8G

Formatting '/kvm/images/rsas-code.qcow2', fmt=qcow2 size=8589934592 encryption=off cluster_size=65536 lazy_refcounts=o
ff

[root@localhost rsas]#

Step 2 Create a VM, as shown in Figure 2-110.

virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-
V6.0R04F00-37872.1is0 —--disk /kvm/images/rsas-code.qgcow?2, format=gcow2,size=8 --vnc -
-vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=linux

#H##

--name: indicates the VM name.

—-ram: indicates the memory.

--vcpus: indicates the number of CPU cores.

--cdrom: indicates the absolute path of the VvRSAS image file.
--vnc: indicates the listening port and listening address for VNC.

Figure 2-110 Creating a VM

root@kvm-debian:~# virt-install --name rsas --ram 8192 --vcpus 4 --cdrom=/iso_store/RSAS-VM-V6.0R04F00-37872.iso --disk
/kvm/images/rsas-code.qcow?,format=qcow?2,size=8 --vnc --vncport=5910 --vnclisten=0.0.0.0 --network bridge=br0 --os-type=Ilinux

Starting install...
Creating domain... | 0B 00:00:00

(virt-viewer:9098): Gtk-WARNING **: cannot open display: localhost:11.0
Domain installation still in progress. You can reconnect to

the console to complete the installation process.

root@kvm-debian: ~#

Step 3 Install VRSAS by using VNC, as shown in Figure 2-111.

Type IP:PORT in the address bar to connect VNC Viewer, where IP is the IP address of the
Linux host of vRSAS, and PORT is 5910 specified during the creation of VM.
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Figure 2-111 Installing VRSAS using VNC

10. 17:5910 (QEMU (rsas6030)) - VNC Viewer -

NSFOCUS Product installer boot menu

[ ]
vanced options >

Step 4 Install the vRSAS image file.

The procedure of installing VRSAS on VNC is the same as that for the VMware Workstation
platform described in Installing the Image File of vRSAS.

a.  During the installation, click OK when you are prompted to mount the data disk, as shown
in Figure 2-112.

Figure 2-112 Only one hard disk detected

b. Click later_install when specifying the data disk location, as shown in Figure 2-113.
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Figure 2-113 later_install

A

Caution

After the ISO installation is complete, the window shown in Figure 2-114 appears. Do
not run the virsh start command to start the new VM. Otherwise, the image is
automatically installed, and the qcow?2 image cannot be created.

Figure 2-114 VM created

Step 5 Check the path of the .qcow2 image file, as shown in Figure 2-115 or Figure 2-116.
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Figure 2-115 Viewing the path of the disk image file visually

] 3 uu ’ a) ‘ hd ‘*Eg]
- k

E Overview
pr— Source path: /kvm/images/rsas-code.qcow?2
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= : DISR I
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Shareable: | |
== Memory o
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Figure 2-116 Viewing the path of the disk image file by using commands

[root@localhost ~]# virsh dumpxml rsas |
<domain type="kvm' id="9">
<name>rsas</name>
<uuid>f79ff54a-4cch-47a5-c71f-bf938812995f</uuid>
<memory unit="KiB'>8388608</memory>
<currentMemory unit="KiB'>8388608</currentMemory:>
<vcpu placement="static'>4</vcpu>
<resources>
<partition>/machine</partition>
</resource>
<0S>
<type arch="x86_64" machine="pc-i1440fx-rhel7.0.0"'>hvm</type>
<boot dev="cdrom'/>
<boot dev="hd'/>
</0s>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>destroy</on_reboot>
<on_crash>destroy</on_crash>
<devices>
<emulator>/usr/libexec/qemu-kvm</emulators
<disk type='file' device="disk'>
<driver name='gemu' type="qcow2'/>
<source fi]e:'/kvm/images/rsas—code.qcowZ'/>]

<
<target dev="hda’'| bus="ide"'/>

<alias name="1de0-0-0"/>
<address type='drive' controller="'0" bus="'0" target="0" unit="'0"/>
</disk>

Save the code disk as a dual-disk image for use.
cp /kvm/images/rsas-code.qcow2 /kvm/images/shuangpan.gcow2
-—--End
2. Install VRSAS with two disks
Step 1 Install VRSAS by using the dual-disk qcow2 image, as shown in Figure 2-117.

virt-install --name rsas --ram 8192 --vcpus 4 --import --disk
path=/kvm/images/rsas-shuangpan.qcow2 --network bridge=br0 --vnc --vncport=5911 —--
vnclisten=0.0.0.0 --os-type=linux

(3di

--name: indicates the VM name.

—-ram: indicates the memory.

--vcpus: indicates the number of CPU cores.

--disk: indicates the absolute path of the dual-disk gcow2 image file.
--vnc: indicates the listening port and listening address for VNC.
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Figure 2-117 Using the dual-disk gcow2 image

root@kvm-debian:~# virt-install --name rsas --ram 8192 --vcpus 4 --import --disk path=/kvm/images/rsas-shuangpan.qcow?2 --network
bridge=br0 --vnc --vncport=5911 --vnclisten=0.0.0.0 --os-type=linux

Starting install...
Creating domain... | 0B 00:00:00

(virt-viewer:6616): Gtk-WARNING **: cannot open display: localhost:11.0

Domain creation completed. You can restart your domain by running:
virsh --connect gemu:///system start RSAS

root@kvm-debian:~#

Step 2 Type IP:PORT in the address bar to connect VRSAS via VNC, where IP is the IP address of
the Linux host of VRSAS, and PORT is 5911 specified during the creation of VM. After the
booting process ends, VRSAS will be automatically shut down, as shown in Figure 2-118 and
Figure 2-119.

Figure 2-118 Dual-disk image loading

& 10. 1:5911 (QEMU (RSAS)) - VNC Viewer

Booting Suysten’

starting version 232

Figure 2-119 vRSAS shutdown

root@kvm-debian:~# virsh list --all
Id Name State

- LRSAS shut off
- shut off

Step 3 Create a data disk.
gemu-img create -f gcow2 /kvm/images/rsas-data.gcow2 160G
Step 4 Mount the disk data to vVRSAS.

a. After vRSAS is installed, it is shutdown. In this status, run the following command to
confirm that the code disk ID is hda, as shown in Figure 2-120.

virsh dumpxml RSAS
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Figure 2-120 Querying the device ID of the code disk

[root@localhost images]é virsh dumpxml RSAS]
<domain type="kvm'>
<name>RSAS</name>
<uuid>dddc0a0c-8675-ee98-8e21-4ef9bef35e37</uuid>
<memory unit="KiB'>8388608</memory>
<currentMemory unit="KiB'>8388608</currentMemory>
<vcpu placement="static'>4</vcpu>
<0S>
<type arch="x86_64" machine="pc-1440fx-rhel7.0.0">hvm</type>
<boot dev="hd'/>
</OS>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>restart</on_reboot>
<on_crash>restart</on_crash>
<devices>
<emulator>/usr/Tibexec/qemu-kvm</emulator>
<disk type='file' device="disk'>
<driver name='gemu' type='qcow2'/>
<source fi]e:'/kvm/images/rsas-shuangpan.qcow2'/>|
[<target dev="hda ]bus="ide'/>
<address type='drive' controller="0" bus="0"' target='0" unit="0"/>
</disk>

b. Mount the data disk, with an ID numbered sequentially based on the ID of the code disk
obtained in the previous step. For example, if the code disk is hda, the data disk must be
set to hdb, as shown in Figure 2-121.

virsh attach-disk --domain RSAS --subdriver gcow2 --source /kvm/images/rsas-
data.gcow2 --target hdb --persistent

(3di

--domain: indicates the name of VvRSAS.

—--source: indicates the source path of the disk to be installed.
--target: indicates the target disk added to the virtual machine.

Figure 2-121 Adding a data disk

[root@localhost images]# virsh attach-disk --domain RSAS --subdriver qcow2 --source /kvm/images/rsas-data.qcow2 --targ
et hdb --persistent
A Th B A0 B =

c.  After the configuration is complete, check the configuration files of VRSAS, which already
contains the data disk, as shown in Figure 2-101.

virsh dumpxml RSAS
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Figure 2-122 Checking the data disk in the configuration file

[root@localhost images]ﬁ virsh dumpxml RSAS
<domain type="kvm'>
<name>RSAS</name>
<uuid>dddc0a0c-8675-ee98-8e21-4ef9bef35e37</uuid>
<memory unit='KiB'>8388608</memory:>
<currentMemory unit="KiB'>8388608</currentMemory>
<vcpu placement="static'>4</vcpu>
<0S>
<type arch="x86_64" machine="pc-i440fx-rhel7.0.0"'>hvm</type>
<boot dev="hd'/>
</0s>
<features>
<acpi/>
<apic/>
<pae/>
</features>
<clock offset="utc'/>
<on_poweroff>destroy</on_poweroff>
<on_reboot>restart</on_reboot>
<on_crash>restart</on_crash>
<devices>
<emulator>/usr/libexec/qgemu-kvm</emulator:>
<disk type="file' device="disk'>
<driver name='qemu' type='qcow2'/>
<source file='/kvm/images/rsas-shuangpan.qcow2'/>
<target dev="hda' bus="ide'/>
<address type='drive' controller="'0" bus="'0"' target='0" unit="0"/>
</disk>
<disk type='file' device="disk'>
<driver name='gemu' type='qcow2'/>
<source file='/kvm/images/rsas-data.qcow2'/>
<target dev="hdb' bus="ide'/>
<address type='drive' controller="'0" bus="'0"' target='0" unit="1"/>
</disk>

Step 5 Start the VRSAS and wait until the installation is complete.
virsh start rsas

—End

Adding a NIC

Initially, VRSAS only has a NIC enabled for its management interface. To use the scan
interface, follow these steps to add a NIC:

Step1 Keep VRSAS in the shutdown state and add a NIC.

virsh attach-interface rsas --type bridge --source br0 --persistent

#bridge indicates the bridge mode, and br0 indicates the name of a bridge NIC on
the host. Select a NIC as required. Multiple network interfaces cannot be bridged
to the same bridge NIC.
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Figure 2-123 Adding a NIC

root@kvm-debian:~# virsh attach-interface rsas --type bridge --source br0 --persistent
Interface attached successfully

root@kvm-debian:~# virsh domiflist rsas Query NIC information of vRSA
Interface Type Source  Model MAC

bridge br0 rtl8139  52:54:00:b4:23:b6
- bridge br0 rtl8139  52:54:00:20:df:5e

root@kvm-debian:~#

Step 2 Start VRSAS.

virsh start rsas

Step 3 Log in to the console user interface and check that the network configuration already contains
the scan interface.

Figure 2-124 Scan interface added

I 1066, 1:5910 (QEMU (rsas)) - VNC Viewer

Set Scan Interface

bet Scan Interfacel

Return

-—-—-End
Mounting the Dongle
A Do not remove the dongle when VRSAS is in use. Otherwise, VRSAS would
Caution automatically exit.

Step1 Create an XML file, for example, usb.xml.
The product ID in the XML should be the same as that in the result of the Isusb command.

®  Method 1: In the example file as follows, the product id parameter is set to be the same
as the execution result of the Isusb command, as shown in Figure 2-125.

<hostdev mode='subsystem' type='usb'>
<source>
<vendor id='0x0471'/>
<product id='0x485e'/>

</source>
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¥

</hostdev>

Figure 2-125 Result of the Isusb command in method 1

[root@localhost images]# 1susb

Bus 001 Device 001: ID 1d6b:0002 Linux Foundation 2.0 root hub
Bus 002 Device 004: I :485e Philips (or NxP)
Bus 002 Device 003: ID : VMware, Inc. virtual USB Hub

Bus 002 Device 002: ID Oeof 0003 VMware, Inc. Vvirtual Mouse
Bus 002 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub
[root@localhost images]# |

®  Method 2: In the example file as follows, both the bus and device parameters are set to
be the same as the execution result of the Isusb command, as shown in Figure 2-126.

<hostdev mode='subsystem' type='usb'>
<source>
<address bus= '002' device='004' />
</source>
</hostdev>

Figure 2-126 Result of the Isusb command in method 2

[root@]oca1host images]# Tsusb

: ID 1d6b:0002 Linux Foundation 2.0 root hub
ID 0471:485e Philips (or NXP)

B 2 g * ID 0e0f:0002 vMware, Inc. virtual USB Hub
Bus 002 Device 002: ID 0e0f:0003 vMware, Inc. Virtual Mouse
Bus 002 Device 001: ID 1d6b:0001 Linux Foundation 1.1 root hub
[root@localhost images]#

Step 2 Check the VM's instance name and mount the dongle to the corresponding device, as shown
in Figure 2-127.

virsh attach-device rsas usb.xml --persistent

Figure 2-127 Mounting the dongle

root@kvm-debian:~# virsh attach-device rsas usb.xml --persistent
Device attached successfully

Step 3 Run the following command to verify that the mount is successful, as shown in Figure 2-128.

virsh dumpxml rsas

Figure 2-128 Dongle mounted permanently

<hostdev mode='subsystem’ type='usb’' managed='no’'>
<source>
<address bus="'2" device="4"/>
</source>
<address type='usb’ bus="0" port="1"/>
</hostdev> o
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Performing Initial Configuration

NSFOCUS RSAS Installation Guide

After logging in to the console of VRSAS, you should continue to perform initial
configuration. For details, see Performing Initial Configuration.

Importing a License

For how to import a license, see Importing a License.

2.2.6.3 Uninstallation Procedure

To delete VRSAS from the KVM platform, run the following commands

virsh destroy rsas
virsh undefine rsas

locate rsas

#Shuts down vRSAS.
#Undefines vRSAS.
#Finds vRSAS-related files.

Run the rm command to delete the files found in the previous command line.

updatedb

2.2.7 Installation on OpenStack

This section describes how to install VRSAS on a standard OpenStack platform.

2.2.7.1 Preparations

#Updates the locate data file.

Table 2-7 lists preparations to be made for installing vVRSAS on OpenStack.

Table 2-7 Preparations to be made for installing VRSAS on the OpenStack platform

Item Description
OpenStack server IP address IP address of a computer that can properly connect to the
(standard platform) network,
Account Account with privileges of a system administrator.
vRSAS CD Contains an image file (.iso) of VRSAS.
IP address IP address of the scan interface of vVRSAS.
Authentication *  License that enables VRSAS to be launched properly.
license
*  Unique authorization hash value granted to vRSAS.
* [P address of a CAA platform and license of VRSAS.
* License of VRSAS for authentication by NSFOCUS
security cloud.
S,
Note
You can select either of the authentication modes.
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2.2.7.2 Installation Procedure

Obtaining the Image File of vRSAS

For how to obtain the image file of VRSAS, see Obtaining the Image File of vVRSAS.

Creating a VM

Step1

Step 2

Step 3

To create a VM, follow these steps:

Create and obtain the .qcow2 image file.

NSFOCUS RSAS Installation Guide

For how to create the image file, see Installing a QCOW2 Image File.

Log in to the OpenStack platform.

Figure 2-129 OpenStack platform

= -
Lsopenstack. =admin~ & admin ~
Project
Identity / Projects
Admin >
Projects
Identity v
Project Name =~ Filter || 4 Create Project
Users
Displaying 2 items
Groups
O Name Description Project ID Domain Name Enabled Actions
Roles
[m] Imit admin tenant B5eec563c¢ 19f412faee7d69cbIcb6907 Default Yes Manage Members | v
Application Credentials
n) Tenant for the openstack services ab29334e7ebe4ffa8163dd224bc 17930 Default Yes Manage Members = v
Upload the vRSAS image file to OpenStack.
.
a. Choose Project > Compute > Images.
Figure 2-130 Images page
= =
fsopenstack. =admin~ & admin v
Project
Project / Compute / Images
APl Access
o v IMAGES
Overview Q | Click here for filters or ful text search x ||+ Create Image
Instances
Displaying 4 items
Y
Koy Pairs 0 Owner Name “ Type Status Visibility Protected Format Size
ServerGroups O > admin  cirfos Image Active  Public No RAW ],2; Launch | v
Volumes > 2.00
O > admin  rsasr Image  Active Public No RAW Gé Launch  +
Network >
O > admin  WVSSF02-new Image Active  Public No acowz %490 " e [«
Object Store >
Admin > O > admin WVSSF02-test Image  Active Public No acow2 P?SZ e Launch  +

b. Click Create Image.
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Figure 2-131 Creating an image

Create Image X
Image Details % Image Details
Specify an image to upload to the Image Service
Metadata Image Name¥* Image Description

Image Source
File*

Format*

Image Requirements

Kernel Ramdisk
Choose an image v Choose an image v
Architecture Minimum Disk (GB) Minimum RAM (MB)

Image Sharing

Visibility Protected

Public | Private Yes | No

% Cancel Bac Next >

c.  Specify a name for the image file, browse to the .qcow2 VRSAS image file, select Raw as
the image format, and click Create Image.
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Figure 2-132 Uploading the .qcow2 vRSAS image file

Create Image

Image Details Image Details
Specify an image to upload to the Image Service.

Metadata Image Name* Image Description

nsfocus-product

Image Source
File¥*

nsfocus-product.qcow2

Format¥*

Raw v

Image Requirements

Kernel Ramdisk
Choose an image v Choose an image v
Architecture Minimum Disk (GB) Minimum RAM (MB)
0 0

Image Sharing
Visibility Protected

Public | Private Yes | No

% Cancel

ac Next > v Create Image

d.  On the Images page, the uploaded image file is listed, as shown in Figure 2-133.

Figure 2-133 Images page

S openstack. =admin~ & admin ~
Project v
Project / Compute / Images
API Access
Compute v Images
Overview - N R
Q | Click here for filters or full text search. X+ Create Image
Instances

Displaying 4 items

Disk

O Owner Name+ Type  Status  Visibility  Protected Size
Key Pairs Format
Server G tive W 1216
ServerGroups (O > admin  cimos Image Active  Public No RAW = Launch |~
Volumes > ™
0 > admin nsfocus-product Image  Active Public No Qcow2 Gé Launch |~
Network >
T . 70400
O > admin  WVSSFO2-new Image Active  Public No acowz 7 Launch | v
Object Store > M8
. 66894
Admin > 0 > admin Image Active  Public No acowz 7 Launch | v

MB

Identity > Displaying 4 items

Step 4 Create an instance.

a. Choose Project > Compute > Instances.
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Figure 2-134 Instances page

=
fiopenstack. =admin~ & admin ~
Project
Project / Compute / Instances
APl Access
compet Instances
Compute
Overview

Instance D=~ | | Fiter | & Launch Instance

Instance Name Image Name IP Address Flavor Key Pair Status Availability Zone Task Power State Age Actions

Images
No items to display.
Key Pairs

Server Groups

Volumes >
Network >

Object Store >
Admin >
Identity >

b. Click Launch Instance.

Figure 2-135 Creating an instance

Launch Instance X
. Please provide the initial hostname for the instance, the availability zone where it will be deployed,

Details % ) A . ., )

and the instance count. Increase the Count to create multiple instances with the same settings.
Source % Instance Name % Total Instances

(10 Max)

Flavor *

Description 50%
Networks %
Network Ports Availability Zone W 4 Current Usage

1 Added
nova v 5 Remaining

Security Groups

Count *
Key Pai
Scheduler Hints
Metadata
% Cancel Bac Next>

c. Configure the instance name and count and click Next to open the Source page.

Copyright © NSFOCUS 108 V6.0R04F04



==

”r::. NSFOCUS NSFOCUS RSAS Installation Guide

Figure 2-136 Source page

Launch Instance
, ©
Details % Instance source is the template used to create an instance. You can use an image,
elans a snapshot of an instance (image snapshot), a volume or a volume snapshot (if
enabled). You can also choose to use persistent storage by creating a new volume.
m Select Boot Source Create New Volume
Flavor % Image M Yes | No
N ) Volume Size (GB) * Delete Volume on Instance Delete
Networks %
1 Yes | No
Network Ports
Allocated
Security Groups Name Updated Size Type Visibility
Select an item from Available items below
Key Pair
v Available
Configuration Select one
Q  Click here for filters or full text search x
Server Groups . -
Name Updated Size Type Visibility
Scheduler Hints > cirros 10/24/19521PM 1216 MB raw Public ~
Metadata I> nsfocus-product 11/7/192:12PM  2.00 GB qcow2  Public ,» I
> WVSSF02-new 10/31/19 406 PM 704.00 MB qcow2  Public S
> WVSSF02-test 10/25/19 525 PM 668.94 MB qcow2  Public 7~
% Cancel < Back Next> | aunch Insta

*
d. Configure the volume size. In the Available area, click in the line of the vVRSAS
image file to upload the file, which is then displayed in the Allocated area. Click Next to
open the Flavor page.
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Figure 2-137 Flavor page

NSFOCUS RSAS Installation Guide

Launch Instance
~ . (2]
Details % Flavors manage the sizing for the compute, memory and storage capacity of the instance.
Allocated
Source Total Root Ephemeral .
Name VCPUS RAM Disk Disk Disk Public
m > gSr\,CU 4 4GB 153 GB 3GB 150 GB Yes ¥
Networks %
v Available +
Network Ports Select one
Q | Click here for filters or full text search x
Name  vcpus Ram o@ Root Ephemeral Public
Key P Disk Disk Disk
ey Pai
L > ftest 2 2MB 70GB 20 GB 50 GB Yes 2+
Connguration
4 4 512 10 el e
Server Groups > mitiny 1 MB 1 GB 1 GB 0GB Yes 1+
Scheduler Hints > mismal 1 2GB 20GB 20GB 0GB Yes L3
Metadata
e > g“med‘“ 2 4GB 40GB  40GB 0GB Yes N
> milarge 4 8GB 80GB 30GB 0GB Yes 4+
> mi.xlarge 8 16GB 160 GB 160 GB 0GB Yes £
% Cancel <Back Next >
e. Click to allocate the storage disk space, which should be up to the minimum

configuration requirements listed in Table 2-1. Click Next to open the Networks page.

f.  Configure network settings and click Next. Continue to configure other settings until

metadata configuration is complete.

g.  Click Launch Instance to return to the Instances page. The created instance is displayed

on this page, as shown in Figure 2-138.

Figure 2-138 New instance created

f:openstack. =admin~
Project
Project / Compute / Instances
APl Access
R Instances
Compute v
Overview
Displaying 1 item
Images
O Instance Name Image Name IP Address Flavor
Key Pairs
nsfocus-produc . . PR . -
o | nsfocus-product  192.168.100.13, 10.65.199.196 NS
Server Groups
[P— 5  Displaying 1item
Network >
Object Store >
Admin >
Identity >

& admin v

nsfocus Filter || & Launch Instance ore Actions ¥

Key Pair  Status Availability Zone Task Power State Age Actions
Shutoff nova None ShutDown  6days, 20 hours | Startlnstance | v

Copyright © NSFOCUS 110

V6.0R04F04



=-NSFOCUS NSFOCUS RSAS Installation Guide

—End

Installing the Image File of vRSAS

The procedure of installing VRSAS on the OpenStack platform after it is started is the same as
that for the VMware Workstation platform described in Installing the Image File of vVRSAS.

To start VRSAS, follow these steps:
Step1 Log in to the OpenStack platform.
Step 2 Choose Project > Compute > Instances.

Step 3 On the Instances page, in the line of VRSAS (nsfocus-product in this document), click Start
Instance in the Actions column.

If a window shown in Figure 2-139 appears, wait patiently until the installation page appears.

Figure 2-139 Instance being started

Booting System’

[ ©.017660] Spectre UZ : Spectre mitigation: LFENCE not serializing, switchin
g to generic retpoline
[ 0.030919] . . HP-BIOS bug: 8254 Limer nol connected to 10-APIC

—End

Performing Initial Configuration

After logging in to the console of VRSAS, you should continue to perform initial
configuration. For details, see Performing Initial Configuration. To log in to the console of
vRSAS, follow these steps:

Step1 Log in to the OpenStack platform.
Step 2 Choose Project > Compute > Instances.

Step 3 On the Instances page, in the line of VRSAS (nsfocus-product in this document), click Start
Instance in the Actions column.

Step 4 Click the instance name of VRSAS to display an overview of the instance.
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Figure 2-140 Instance overview
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fsopenstack. madmin~

nsfocus-product

m Name n

D

Description

Project ID

Status

Locked

Availability Zone

> Created
Age

> Host

Specs

Flavor Name
Flavor ID
RAM
VCPUs
Disk
Ephemeral Disk

P Addresses
private_network 192.168.100.13

Security Groups

default A

test

Step 5 Click the Console tab.

Figure 2-141 Console

TSopenstack. madmin~

nsfocus-product

—End

& admin v

Create Snapshot | ~
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Conducting License-based Authentication

Step1

Step 2

Step 3
Step 4

Step1

Step 2

Authentication by the Centralized Authorization Platform

To authenticate VRSAS by using a centralized authorization platform, follow these steps:
Access VRSAS by typing https://IP address of scan interface ethl in the address bar.
A page for authentication mode selection then appears, as shown in Figure 2-57.

Select Centralized authorization and click Next.

Figure 2-142 Configuring authentication by a centralized authorization platform

7= NSFOCUS
License

) Select authentication mode o Import license

* Local IP

* Centralized Authorization Platform IP

Device Hash: String provided to NSFOCUS (support@nsfocusglobal comm) for generating a license for use
f this device

Technical Support:  400-818-6868

Vendor URL:  hitps:/www.nsfocus.com

Type Local IP and Centralized Authorization Platform IP and click Next.
Authorize the device on the specified centralized authorization platform.

—End

Authentication by NSFOCUS Security Cloud

To authenticate VRSAS by using NSFOCUS security cloud, follow these steps:
Access VRSAS by typing https://IP address of scan interface ethl in the address bar.
A page for authentication mode selection then appears, as shown in Figure 2-57.

Select Security cloud-side authentication and click Next to upload a license.
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Step 3

Step1

Step 2

Figure 2-143 Uploading a license

= NSFOCUS

License
) Select authentication mode e Import license

Authentication Server:  auth apl nsfocus.com

Upload License: L. Click to Upload

or activation.
Device Hash: ~String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use.
of this

Technical Support: ~ 400-818-6868

Vendor URL:  hitps:/Awwwnsfocus.com

Select the authorization server, import a valid license, and click Next.

—End

Authentication by the ESP-L Platform

To authenticate VRSAS by using the ESP-L platform, follow these steps:
Access VRSAS by typing https://IP address of scan interface ethl in the address bar.
A page for authentication mode selection then appears, as shown in Figure 2-57.

Select ESP-L certification and click Next. Wait until ESP-L issues a license.

Figure 2-144 Selecting the ESP-L authentication

=< NSFOCUS
License
@ seect autnentication mode
@
Centralized Securty cloud-side License-based o certeator
authorization authentication authentication Fer e
Device Hash:  String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use
of this device
Technical Support: 400-818-6868
Vendor URL: ~ hitps/www.nsfocus com

2.2.7.3 Uninstallation Procedure

To delete VRSAS from the OpenStack platform, follow these steps:

Step1 Log in to the OpenStack platform.
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Step 2 Choose Project > Compute > Instances.

Step 3 On the Instances page, in the line of VRSAS, select Delete Instance from the Actions drop-

down list.

VRSAS is then completely removed from the datastore.

Figure 2-145 Deleting the vVRSAS instance

3openstack. =admin~

v - -
Project/ Compute

Instances

O Instance Name Image Name P Address

Displaying 1 item

nsfocus-product  192.168.100.13, 10.65.199.196 N

& admin

Instance Name = v f Filter | & Launch Instance

Flavor Key Pair ~Status Availability Zone  Task Power State  Age Actions

Active nova None Running 6days, 20 hours  Create Snapshot |

—End

2.2.8 Installation on Xen

This section describes how to install VRSAS on XenServer.

2.2.8.1 Preparations

Table 2-8 lists preparations to be made for installing vVRSAS on XenServer.

Table 2-8 Preparations to be made for installing VRSAS on the Xen platform

Item

Description

XenServer (server) | Host

Computer with XenServer installed.

IP address

IP address of the host that can properly connect to the network.

Account

Account with privileges of a system administrator.

XenCenter (client) Host

Computer with XenCenter installed.

vRSAS CD

Contains an image file (.iso) of VRSAS.

IP address

IP address of the scan interface of VRSAS.

Authentication
license

* License that enables VRSAS to be launched properly.

*  Unique authorization hash value granted to vRSAS.
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Item

Description

IP address of a CAA platform and license of vRSAS.

License of VRSAS for authentication by NSFOCUS
security cloud.

N,

Note

You can select either of the authentication modes.

2.2.8.2 Installation Procedure

Obtaining the Image File of vRSAS

For how to obtain the image file of VRSAS, see Obtaining the Image File of vVRSAS.

Creating a VM

To create a VM, follow these steps:

Step 1 Share the local folder that contains the vVRSAS image file.

The following uses Windows 7 as an example to show how to share a folder.

Figure 2-146 Sharing a folder

Network Path
Not Shared

- |psfocus-product Properties!
General | Shamg | Securty | Previous Versions | Customize
Network File and Folder Sharing

nefocus product
§) Mot Shared

Advanced Sharng
Set custom pemmissions, create mukiple shares, and set other
‘advanced sharing options.

¥ Advanced Shaning.

Password Protection

People must have
computer to access shared ft

To change this setting, use the Network and Sharing Center

3 user account and password for this
folders.

Step 2 Log in to XenCenter.

Step 3 Connect XenCenter to XenServer.

a. Click

In the Add New Server dialog box, type the IP address, user name, and password of

XenServer, and click Add.

XenCenter now connects to XenServer.
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Figure 2-147 Adding a new server

Enter the host name or IP address of the server you want to add
and your user login credentials for that server.

Server: |

User login credentials

Username: root

Password:

Step 4 Upload the VRSAS image file to XenServer.

a.  On the page shown in Figure 2-148, click the Storage tab in the right pane.

Figure 2-148 General properties of XenServer

£ XenCenter =ren X
View Pool Server VM Storage Templates Tools Help
Q@ 8Back - () Forvard - | [ Add New Server | BE] New Pool ¥ New Storage ] New M | (@) Shut Down B Reboot ([} Suspend

Search Q. | [l xen-nsfocus (Unlicensed) Logged in as: Local root account

B A Renlenter General [ Memory | Storage [ Networking [ NICs | Console | [users [ search]

o ol

Server General Properties

Properties Expandall  Collapse all
General | &
Management Interfaces | (v I
Memory | &
Version Details | &
License Details | &
CPUs v
Updates | &

‘ﬁ Infrastructure

& Objects
22, Organization Views
O~ ot Semdhes

A Notifications @

b.  On the Storage tab page, click New SR..., which refers to New Storage Repository.
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Figure 2-149 Storage repositories

x C=rea—x—)

Q) Back + () Forvard | [T Add New Server | B New Pool ¥ New Storage ] NewvM | (@) ShutDown () Reboot ([} Suspend

View Pool Sever VM Storage Templates Tools Help

Search. Q. [7 xen-nsfocus (Unlicensed) Logged in as: Local root account
B fo XerCenter General | Memory | Storage | Networking | NICs | Console | Performance | Users | Search
- (et oo et [ G| ot e s [ s
Storage Repositories
Storage
Name Description | Type | Shared | Usage Size Virtual allocation
150 library CIFSISO ... 150 Yes 40% (393 GBused) 97.7GB 4GB
=3 Removable storage on xen-nsfocus Physicalre.. udev  No 0%(©0Bused) 08 08
=)0 CIFSISO ... 150 Yes 40% (393 GBused) 97.7GB 4GB
% Local storage on xen-nsfocus localstora.. B3 No 3% (30.6 GBused) 8759GB 627 GB
DVD drives on xen-nsfocus Physical DV... udev  No 0%(0Bused) 0B 0B
) Infrastructure
@ Objects NewSR.. | Reclaim freed space Properties
&2, Organization Views -
O, saved Searches o
A Notifications @

c. Inthe New Storage Repository dialog box, select Windows File Sharing (SMB/CIFS)
and click Next.

Figure 2-150 Specifying the type of the new storage repository

4 - WL W ee— -— - - - - Y
€ New Storage Repository - xenserver-nsfocus [e=3 =

% Choose the type of new storage o

Virtual diskstorage

Name Windows File Sharing (SMB/CIFS)
- Block based storage
Location i Select this option if you have a library of VM installation ISO
D iscst images available as 2 Windows (SMB/CIFS) share that you
5 Hardware HBA want to attach to your host or pool.
*) Software FCoE
File based storage
O NFS
IS0 library

© Windows File Sharing (SMB/CIFS)
5 NFSISO

ciTRIX

s>

d.  On the Name page, specify a name for the new storage repository and click Next.
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Figure 2-151 Naming the new storage repository

. .. A .. | MW= [ S

Provide a name and a description (optional) for your SR.

SMBISO library

v Autogenerate description based on SR settings (e.g., IP address, LUN etc.)

€3 New Storage Repository - xenserver-nsfocus
What do you want to call this Storage Repository?
Type
Location Name:
2. .
ciTrIX

< Previous Next >

Cancel

e. On the Location page, type the path of the shared folder configured in Step 1 and click

Finish.

Figure 2-152 Typing the path of the ISO storage

% Enter a path for your SMB ISO storage

Type
Name

Share Name:

Username:

Password:

CiTRIX

€3 New Storage Repository - xenserver-nsfocu: E : E.

Provide the name of the share where your SR is located. You can optionally specify alternative credentials by
setting the server options.

\\serverIP\ISO_library

Example: \\server\sharename

V' Use different user name

administrator

< Previous

Finish Cancel |

4

Step 5

Choose ISO library from the left pane, click the Storage tab, and then click New VM.
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Figure 2-153 Storage page

£ 150 library on 'xen-nsfocus’ Logged in as: Local root account
General | Storage | Search
Virtual Disks
Disks
Name Description Size Virtual Machine
nsfocus-product.iso 979.2 MB
Rescan Properties Move... Delete

Step 6 Inthe New VM dialog box, choose Template > Other install media and click Next.

Figure 2-154 Selecting a VM template

0 New VM
@' Select a VM template o
Search Q
Name Name Category Template details
Installation M :
nstallation Media & Ubuntu Maverick Meerkat 1010 (32-bit) (ex... Ubuntu If the operating system you plan
Home Server . . to use is not listed, you may be
0 Ubuntu Maverick Meerkat 10.10 (64-bit) (ex... Ubuntu able to install it by selecting this
CPU & Memory <0 Ubuntu Precise Pangolin 12.04 (32-bit) Ubuntu template. We recommend that
Storage only advanced users attempt to
9 < Ubuntu Precise Pangolin 12.04 (64-bit) Ubuntu use this template, and you should
Networking G Ubuntu Trusty Tahr 14.04 Ubuntu note that our products have been
tested running only the
Finish <3| Ubuntu Xenial Xerus 16.04 Ubuntu supported distributions and
v " i . . specific versions covered by the
Yinhe Kylin 4 (64-bit) YinheKylin B T e ar e
0 Citrix XenApp on Windows Server 2008 (32-... Citrix
0 Citrix XenApp on Windows Server 2008 (64-... Citrix
€ Citrix XenApp on Windows Server 2008 R2 (... Citrix
(8] Other install media Misc 2
CiTR!X' [7] Copy host BIOS strings to VM
o>

Step 7 On the Name page, type the name of the new VM and click Next.
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Figure 2-155 Naming the new VM

© New VM - - — - - =
Tﬂ‘ Name the new virtual machine e
==
Template Enter a name that will help you to identify the virtual machine later. This could be a name that describes its

| e | software and hardware such as RHEL DHCP Server or Exchange 2007 Client Access Server. This name will
also be displayed in XenCenter's Resources pane and can be changed later.
Installation Media
You can also add a more detailed description of the VM, if you want.
Home Server

CPU & Memory Name: nsfocus-product

Storage Description:
Networking
Finish

citRIX'

< Previous Next > Cancel

Step 8 On the Installation Media page, click Install from ISO library or DVD drive, select the
vRSAS image file, and click Next.

Figure 2-156 Locating the operating system installation media

-
© New'M - " B (=] fmtsw
@' Locate the operating system installation media e
Template Select the installation method for the operating system software you want to install on the new VM.

Name

Installation Media & Install from ISO library or DVD drive:
Home Server nsfocus-product.iso v  NewISO library...

CPU & Memory

" Boot from network
Storage
Networking

Finish

ciTRIX

< Previous Next > Cancel

Step 9 On the Home Server page, click Place the VM on this server and click Next.
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Figure 2-157 Specifying a home server

r "
© NewvM o= e
@ Select a home server o

Template

When you nominate a home server for a virtual machine, the virtual machine will always be started up on

Name that server if it is available. If this is not possible, then an alternate server within the same pool will be
selected automatically.

Installation Media

CPU &M _
emen © Place the VM on this server:

Storage

. ', xenserver-nsfocus 7.0 GB RAM available (8.0 GB total)

Networking

Finish

citrRIX

<Previous | [ Net> | [ Cancel

Step 10 On the CPU & Memory page, configure memory and CPU parameters and click Next.

The size of memory and the number of CPUs should meet the minimum configuration
requirements listed in Table 2-1.

Figure 2-158 Configuring CPUs and memory

) New VM =) S
M Allocate processor and memory resources o
Template Specify the number of virtual CPUs, their topology, and the amount of memory that will be allocated to the

new virtual machine.

Name
Installation Media Number of vCPUs:
H Se

Ome SErver Topology: [2 sockets with 1 core per socket -
CPU & Memory
Storage

. Memory: 40965 MB

Networking
Finish

2 .

CiTRIX
<Previous | [ Net> | [ Cancel

Step 11 On the Storage page, select Use these virtual disks and click Add.

In the Add Virtual Disk dialog box, configure the virtual disk name, specify the disk size,
and click Add.
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Figure 2-159 Adding a virtual disk

€ New VM = %

@l Cof' @ Add Virtual Disk T lemw) ©

Enter a name, description and size for your virtual disk. The size of your disk and the home server setting of any VM the

Template disk belongs to will affect which storage locations are available. nge the

Name Name: nsfocus-product-disk

Installation o e
Description:

Home Seny

CPU & Mel e

o |
Networking | 37 [ 150000=] [6B

Finish Lecalion: M I R Ty 837.26 GB free of 87591 GB

il

citey e

< Previous | lext > | Cancel

A

Step 12 On the Storage page, select a desired virtual disk and click Next.
Step 13 On the Networking page, add network interfaces as required and click Next.

Figure 2-160 Adding network interfaces

'Q New VM S|

@ Configure networking on the new VM o

Template The virtual machine template you have selected provides the virtual network interfaces listed below. You
Name can configure or delete the default virtual network interfaces here, and add more if required.
Installation Media Virtual network interfaces on F04
Home S
ome Server MAC Network
CPU & Memory ", <autogenerated MAC> Network 0
=
Storage

£ <autogenerated MAC> Network 0

o Delete

Finish /£, <autogenerated MAC> Network 0
(@) Using a Default template, you can configure up to 4 virtual network interfaces during
VM creation. To configure more than 4, create a Custom template or add extra virtual
network interfaces from the Network tab after creating the new VM.
) .
CITRIX
<Previous | [ Net> | [ Cancel
U )

Step 14 On the Finish page, confirm that all information is correct and click Create Now.
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Figure 2-161 Finishing the creation process

€) New VM = =
19' Ready to create the new virtual machine o
Template All the necessary information has been collected and the wizard is ready to provision the new virtual
Name machine using the settings shown below.
Installation Media Review these settings, then click Previous if you need to change anything. Otherwise, click Create Now to
Home Server create the new VM. It may take several minutes to create the new VM.
CPU & Memoty Template Other install media -
Storage Name nsfocus-product
Networking Install Method D
_ Installation Source nsfocus-product.iso 1
Home Server xen-nsfocus
vCPUs 2 |
Topology 2 sockets with 1 core per socket
Memory 4GB
Nicle 'mrfaciir meadoss Adi-l' 180 20D A
cimlx [V Start the new VM automatically
.
< Previous | Create Now | Cancel
.
—-End

Installing the Image File of vVRSAS
To install the image file of vVRSAS, follow these steps:
Step1 Log in to XenCenter.

Step 2 Choose VRSAS (nsfocus-product in this document) from the left navigation tree and click
Start.
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Figure 2-162 Launching vVRSAS

B erceneer

NSFOCUS RSAS Installation Guide

File View Pool Server VM  Storage Templates Tools

Help

Q) Back ~ () Forward - | [ AddNewserver | BE New Pool ) New Storage ] Newvm | (@) Start Reboot Suspend
Search Q|| [@ nsfocus-product on "xen-nsfocus’ Logged in as: Local root account
B fr Renenter General | Memory | Storage | ing | Console | | Search
= [@ xen-nsfocus
[Py nsfocus—prodect VM 1P, i
@ Start
Copy VM... Expandall  Collapse all
Move VM... =
Export... ~
Take a Snapshot... nsfocus-product f
Convert to Template...
Assign VM to snapshot schedule  »
<None>
Assign to vApp >
<None>
Delete VM...
Unknown
Properties
Hard: isted jzation (HVM)
BIOS strings copied: No
Virtualization state: Not able to receive updates from Windows Update
UuID: 75¢b3426-3675-8341-e662-6d51 bfB3beds
Boot Options v)
[ﬁ Infrastructure CPUs ®)
ﬁ Objects
&2, Organization Views -
O, saved searches c
A Notifications @

Step 3 Click the Console tab to open the console window of vVRSAS.
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Figure 2-163 Console of vVRSAS

[[@ nsfocus-product on "xen-nsfocus’ Logged in as: Local root account

General | Memoryl Storage | Networkingl Console ‘Performance Snapshots | Search‘

DVD Drivel: nsfocus-product.iso v

NSFOCUS RCM Product installer boot me

[ linstall
tdvanced options >
Send Ctrl+Alt+Del (Ctrl+Alt+Insert) ™ Scale wz‘ Undock (Alt+Shift+U) Fullscreen (Ctrl+Enter)

Step 4 Install VRSAS.
For details, see Installing the Image File of VRSAS.

Step 5 Change the boot mode to boot from hard disk as prompted.
a. Right-click VRSAS.
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Figure 2-164 Shortcut menu of VRSAS

File | View Pool Sever VM Storage Templates Tools Help
Q Back ~ Q) Forward 2y Add New Server | BE] New Pool ¥5) New Storage ] NewVM | (@) Start () Reboot
eare, Q| @ nsfocus-product on "xen-nsfocus’ Logged in as: Local root account
& {a XenCenter General | Memory | Storage | Networking | Console e [ search
5 [f xennsfocus
B DD Drivats— nsfocus-productiso -

Copy VM... This VM is currently shut down. Click here to start it.

Move VM...
Export...

Take a Snapshot...

Convert to Template...

Assign VM to snapshot schedule  »
Assign to vApp »

Delete VM...

Properties

[ﬁ Infrastructure

.‘" Objects

42, Organization Views

O saved Searches o
‘.

A Notifications @

Fullscreen (Ctrl+Enter)

™ Scale Undock (Alt+Shift+U)

b. Choose Properties from the shortcut menu.
c.  On the Properties page, choose Boot Options from the left pane, select Hard Disk, and
click OK.
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Figure 2-165 Boot options
76 ‘nsfocus-product’ Properties - - m‘

General @ Boot Options
nsfocus-product
& Custom Fields Choose the devices from which you would like to boot the VM's operating system, and configure the boot device
<None> order. The first item in the list will be scanned first when booting; if boot media is not found, the second device will
CPU and Memory then be scanned, and so on down the list of selected devices.
2 vCPU(s) & 4096 MB RAM
@ Boot Options Boot order: |[y| Hard Disk Move Up I
Boot order: Hard Disk, DVD... W] DVD-Drive Move D
M ove Down I
@ Start Options 0 Network
HA is not available on stan.
o Alerts
None defined
B Home Server
xen-nsfocus
am GPU
License Upgrade Required
%y Advanced Options

Optimize for general use

Cancel

Step 6 Add a network adapter.

vRSAS only provides one network interface (that is, management interface) by default. You
need to add a network adapter to enable the scan interface.

a.  Click the Networking tab

Figure 2-166 Networking page

Search Q) ‘@ nsfocus-product on 'xen-nsfocus’ Logged in as: Local root account
7N ey
8 & anl:emer General l Memory[ Storage | N king | Console[ =I pst I Search‘
= [7l xen-nsfocus
B Virtual Network Interfaces
Networks
Device / | MAC | Limit | Network 1P Address Active
0 06 4 ork 0
A1 96:80:b2:0a:€5:34 Network 1 Unknown No
122 26:7a:da:ff:db:90 Network2  Unknown No
3 fa:12:61:38:87:bc Network 3 Unknown No
) Infrastructure
.0- Objects Add Interface... Properties Remove Activate
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b. Click Add Interface.

Figure 2-167 Adding a virtual interface
= \
€3 Add Virtual Interface &Ld_hJ

Select your network and MAC address for this virtual
interface. You can also optionally define a QoS limit.

Network: | Network 0 hA

MAC address:
(¢ Auto-generate a MAC address

" Use this MAC address: aa:bb:caddiesff

QoS settings:
I” Enable a QoS limit of: Kbytes/s

Add Cancel

c. In the Add Virtual Interface dialog box, configure parameters for the network adapter,
and then click Add.

d. (Optional) Add other network adapters as required.
-—-End

Performing Initial Configuration

After logging in to the console of VRSAS (as detailed in Installing the Image File of vRSAS),
you should continue to perform initial configuration. For details, see Performing Initial
Configuration.

Conducting License-based Authentication

For how to import a license, see Conducting License-based Authentication.

2.2.8.3 Uninstallation Procedure
To delete VRSAS from XenServer, follow these steps:
Step1 Loginto XenCenter.
Step 2 Choose VRSAS from the left navigation tree.
Step 3 Right-click VRSAS and choose Delete VM from the shortcut menu.

VRSAS is then completely removed from the datastore.
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Figure 2-168 Deleting VRSAS

[File | View Pool Sever VM Storage Templates Tools Help
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@ Start
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Copy VM...
Move VM...

Export...

Take a Snapshot.
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Delete VM...
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'."’Objens
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O, saved searches -
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Undock (Alt+Shift+U) | Fullscreen (Ctrl+Enter)
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—End

Copyright © NSFOCUS 130 V6.0R04F04



=-NSFOCUS NSFOCUS RSAS Installation Guide

Initial Login

This chapter contains the following sections:

Section Description

Console-based Management Describes how to log in to the console.

Initial Configuration Provides instructions for initial configuration of RSAS.

Web-based Management Describes the login method and page layout of the web-based manager.

Importing a License for the | Describes how to import a license.
Initial Use

3.1 Console-based Management

With serial connections, you can access the RSAS console to perform functions such as the
initial configuration, status detection, and initialization restoration, which are unavailable on
the web-based manager.

3.1.1 Login

This section describes how to log in to the console.

3.1.1.1 Preparations
Before logging in to the console, prepare the following:

®  One PC, on which terminal software, such as PuTTY, has been installed and can connect
to the console.

®  One serial cable (included in the accessory kit), with one end connecting to the device
and the other to the serial port of the PC.

e Communication parameters, user name, and password (see Default Parameters).

3.1.1.2 Procedure

The following uses PuTTY as an example to describe how to log in to the console user
interface.
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Step1 On the desktop of the PC, right-click Computer/This Computer and select Properties from
the shortcut menu to open the device manager and view the serial port of the current machine.

Figure 3-1 Device manager

& Device Manager - a X
File Action View Help
e m Ao e
v & DESKTOP-O14VMLD A
i Audio inputs and outputs
8 Computer
wa Disk drives
[ Display adapters
«s DVD/CD-ROM drives
g Human Interface Devices
=2 Keyboards
0 Mice and other pointing devices
@ Monitors
¥ Network adapters
v @ Ports (COM & LPT)
i Prolific USB-to-Senal Comm Port (COM6)
@ USB-SERIAL CH340 (COM10)
@ USB-SERIAL CH340 (COM16)
## Communication Port
A Print queues
] Processors
|7 Security devices
¥ Software components
i Software devices
iy Sound, video and game controllers
S Storage controllers
@ System devices v

Step 2 Open PuTTY, configure connection properties of the serial port, and click Open.
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Figure 3-2 Selecting a port for connection

PuTTY Configuration
Category:

[=)- Session

. Logging
=- Teminal

- Keyboard
- Bell

- Features
=) Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours

[=)- Connection
--Data

- Proxy

- Telnet

- Rlogin

+- SSH

- Serial

About

Basic options for your PUTTY session

Specify the destination you want to connect to

Serial line Speed
|com4 |[115200 |
Connection type:

ORaw O Telnet ORlogn (OSSH @) Serial

Load, save or delete a stored session
Saved Sessions

| |

Default Settings Load

10.254.8.15

10.65.123.105

Ubuntu 14.04 Save
Delete

Close window on exit:
OAways (ONever (@ Onlyon clean exit

==

Table 3-1 Connection parameters of the serial port

Parameter

Value

Serial line

Specifies a COM port according to your computer system. For how to find out the
serial port of the current computer, see Step 1.

Speed

Specifies the connection rate, which should be 115200 (bits per second).

Connection type

Specifies a connection type, which should be Serial here.

Step 3 Type the initial user name and password (both are conadmin) of the console administrator to
log in to the console user interface.
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Figure 3-3 Console user interface

—End

3.1.2 Meanings of Frequently Used Keys

On the console user interface, you can only perform operations with the keyboard. Table 3-2
describes meanings of the frequently used keys.

Table 3-2 Meanings of frequently used keys

Keyboard Description

1 Moves up.

1 Moves down.

— Moves left.

— Moves right.

ESC Cancels an operation.

Enter Confirms an operation.

Tab Switches between the input box, OK, and Cancel.
Backspace Deletes the character to the left of the cursor.

3.1.3 Functions

This section describes main functions available on the console.

On your first login as conadmin, change the initial login password. Otherwise, the system
reminds you every time you log in.
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Figure 3-4 Password change reminder

Harning

Please modify the default passwor
d in time!

In either of the following cases, a window shown in Figure 3-5 appears, prompting you to
select a language:

®  You do not change the initial password of the login account conadmin and click
RETURN.

®  You have changed the initial password of the login account conadmin.

Figure 3-5 Selecting a language

| En

whSelect English language.

3.1.3.1 System Management

Select System Administration on the main menu. The System Administration menu
expands, as shown in Figure 3-6.
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Figure 3-6 Console-based management — system administration

System Administration

Turn off

Remote Login Management
Restart Service

Set System Clock

Open Expert Diagnosis

Modify Console Admin Password
Reset Web Admin Password

Reset Web Admin Login Range
Reset Auditor Admin Password
Reset Web Auditor Login Range
Back

| Restart

Restart the system.

On this menu, you can perform the operations listed in Table 3-3.

Table 3-3 System administration operations on the console

Operation Description
Restart Restarts the RSAS system.
Turn Off Shuts down the RSAS system.

Remote Login Management

After the SSH service is enabled, the technical support personnel of
NSFOCUS can remotely log in to RSAS to diagnose faults.

After it is enabled, type an IPv4 address and port number (in the range
of 60000-65535) of the host that is accessible to RSAS. Then the login
key and its QR code used for remote access to RSAS are displayed
below.

Restart Service

Restarts RSAS services. When a system exception occurs, you can
restart system services.

Set System Clock Sets the date and time of the RSAS system.

Open Expert Diagnosis When RSAS is faulty and requires remote assistance, technical support
personnel of NSFOCUS can remotely log in to the faulty device via SSH
and perform troubleshooting in the background.

Modify Console Admin | Changes the password of the console administrator. The password must

Password contain 9 to 20 characters of at least two types of the following: letters,
digits, and special characters (@ # $ "~ ).

Reset Web Admin Password Restores the password for web login to the initial one when the

administrator admin forgets it.

Reset Web Admin Login Range

Restores the default IP addresses through which the admin user can log
in to RSAS.

Reset Auditor Admin Password

Restores the password for web login to the initial one when auditor
forgets it.

Reset Web Auditor Login Range

Restores the default IP addresses through which auditor can log in to
RSAS.
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3.1.3.2 Network Configuration
RSAS provides a scan interface and a management interface. The scan interface is used for

network scanning and the management interface is used for RSAS management. Also, the
administrator can manage RSAS and perform task assessment only via the scan interface.

Configuring the DNS Server

Select Network Settings from the main menu and then select Set DNS, as shown in Figure 3-
7.

Figure 3-7 Console-based management — setting a DNS server

Pay attention to the following when configuring a DNS server:

® At least one DNS server should be configured.
®  The first DNS address must be typed.

®  Make sure that the DNS server are properly configured if the online upgrade is necessary
for RSAS.

Setting the Default Gateway

Select Network Settings from the main menu and then select Set Default Gateway, as
shown in Figure 3-8.
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Figure 3-8 Console-based management — setting the default gateway

Fill in the interface number on which a default route will be generated, such as 0 for the
management interface, 1 for the scan interface 1, and 2 for the scan interface 2. For example,
if you fill in 1, the default route 0.0.0.0 0.0.0.0 eth1 will be generated on the scan interface 1.
If the default gateway is not specified here, the system uses the gateway of scan interface 1 as

the default gateway.

S,

Note

To generate a default route by setting the default gateway, the network interface must

be correctly configured with the gateway address. For details, see Configuring the
Management Interface.

Configuring the Management Interface

Select Network Settings from the main menu and then select Configure Management
Interface, as shown in Figure 3-9.
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Figure 3-9 Console management — configuring the management interface

ss and netmask

Pay attention to the following when configuring the management interface:

®  [Pv4 or IPv6 addresses are assigned via DHCP. After you press Enter, RSAS will
automatically obtain the IP address of the scan interface.

e  Either an IPv4 or IPv6 address can be configured for the management interface. The
default IPv4 address is 192.168.1.1/24.

® [fthe IP address of the RSAS host is on a different network segment from the IP address
of the management interface, you need to add a route for the management interface.

®  The negotiation mode must be set for the management interface.
After the configuration, press Enter to make the settings take effect immediately.

® The management interface and scan interface cannot be configured in the same network
segment.

Configuring the Scan Interface

Select Network Settings from the main menu and then choose Set Scan Interface > Set
Scan Interface 1, as shown in Figure 3-10.

Copyright © NSFOCUS 139 V6.0R04F04



=

V;i'-:—ﬂ NSFOCUS NSFOCUS RSAS Installation Guide

Figure 3-10 Console management — configuring the scan interface

Set Scan

Interf

Set Scan Interfacel
t 2

Pay attention to the following when configuring a scan interface:

IPv4 or IPv6 addresses are assigned via DHCP. After you press Enter, RSAS will
automatically obtain the IP address of the scan interface.

Either an IPv4 or IPv6 address is allowed for a scan interface. The setting takes effect
immediately.

After the configuration, click OK to make the settings take effect immediately.

Make sure that the gateway and DNS server are properly configured if the online
upgrade is necessary for RSAS.

Parameters must be set in the correct format, for example, 255.255.255.0 as the IPv4
netmask.

The management interface and scan interface, and any two scan interfaces must be
configured in different network segments.

Creating a Route for the Management Interface

You can specify an access path to the network by creating or deleting a static route.

Select Network Settings from the main menu and then select Add Management Interface
Route, as shown in Figure 3-11.
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Figure 3-11 Console management — creating a route for the management interface

Pay attention to the following when creating a route:

The default management interface is the M interface. Here, route parameters are set for
this interface.

After you set the IP address, subnet mask, and gateway address and click OK, the
settings take effect immediately.

If an error occurs after you click OK, check whether the IP address and gateway address
are correct.

Deleting a Route of the Management Interface

Select Network Settings from the main menu and then select Delete Management Interface
Route, as shown in Figure 3-12.
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Figure 3-12 Console management — deleting a route of the management interface

Pay attention to the following when deleting a route:

®  After you select Delete Management Interface Route, the routing table of the
management interface appears. Select the route that you want to delete.

®  After you select the route and click OK, the deleted route immediately loses effect and
disappears from the routing table.

Creating a Route for a Scan Interface

Select Network Settings from the main menu and then select Add Scan Interface Route. A
route for a scan interface is added in the same way as that for the management interface. For
details, see Creating a Route for the Management Interface.

Deleting a Route of a Scan Interface

Select Network Settings from the main menu and then select Delete Scan Interface Route.
A route of a scan interface is deleted in the same way as a route of the management interface.
For details, see Deleting a Route of the Management Interface.

3.1.3.3 Network Diagnosis

Select Network Diagnosis from the main menu, as shown in Figure 3-13.
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Figure 3-13 Console management — network diagnosis

Table 3-4 lists network diagnosis tools available on RSAS.

Table 3-4 Network diagnosis tools on the console

Tool Function

Ping Checks the connection between RSAS and the target host. IPv4 and IPv6 addresses
are acceptable.

Traceroute Traces the hops between RSAS and the target host.

Network Status Displays the network connection status of RSAS.

Display Route Displays parameters of the interface used by the routing device to connect to RSAS.

DNS Resolution Displays the domain name resolution information.

3.1.3.4 System Status

Select System Status from the main menu. The System Status menu expands, as shown in
Figure 3-14.
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Figure 3-14 Console-based management — system status

System Status | Dispaly System Version

Display system version and plugin package version.
Check System Status

Check Database Status

Network Status

Network Card

Back

On the System Status menu, you can view status information listed in Table 3-5.

Table 3-5 System status checking on the console

Operation Description

Display System Version | Displays the system and plugin versions of RSAS.

Check System Status Displays the system status of RSAS.

Check Database Status Displays the background database status of RSAS.

Network Status Displays the NIC configuration and routing table of RSAS. Usually, it is used to
check the network configuration.
Network Card Displays the IP address, MAC address, the number of bytes of data transmitted
and received by the NIC. The information is usually used to check whether the
NIC works properly.
\ Ongoing assessment tasks will be stopped during the checking of the system status or
Note database status. To avoid data loss, conduct status checks after all tasks are completed.

3.1.3.5 License Information

Select License Information from the main menu, as shown in Figure 3-15.

You can check the information about the authorized license file of the current system,
including the product type, the start date, end date, and expiry date of the license, as well as
your purchased modules.
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Figure 3-15 License Information

3.1.3.6 Backup and Restoration

Backup and restoration are very important functions of RSAS as the two functions can restore
data in time once the device breaks down.

Select Backup and Restore from the main menu, as shown in Figure 3-16.

Figure 3-16 Backup and restoration

Backup and Restore | System Diagnosis

Diagnose and remediate system anomalies.

Create Restore Point A complete system inspection takes about few hours. Please waiting and
Restore System From Restore Point backup system licence and important data in advance.

Back

Performing System Diagnosis for Automatic Remediation

System diagnosis is to diagnose and fix system faults. The entire diagnosis process takes a
long time. You must back up the system license and important scanning data in advance and
patiently wait until the process is complete.

Select Backup and Restore from the main menu and then select System Diagnosis, as shown
in Figure 3-17.

Figure 3-17 Console-based management — system diagnosis and automatic remediation

Check Badblock and Auto Repair

This function checks and fixes the hard disk for bad blocks.

This process takes a long time, during which all services are stopped. After the process is
complete, the system restarts automatically.
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Creating a Restore Point

A restore point is created for system restoration. A restore point involves the following
information: system configuration, asset information, scanning templates, scanning tasks, and
user information.

Select Backup and Restoration from the main menu and then select Create a Restore Point
to create a restore point. The administrator can manually create a user restore file.

Figure 3-18 Console-based management — creating a restore point

Backup and Restore | Create Restore Point

System Diagnosis Create a restore point.
Create Restore Point

Restore System From Restore Point
Reinstall System
Back

Create Restore Point

There 1s no restore point,Please generate it!

t{ You can create only one restore point each time.
Note

Restoring the System by Using a Restore Point

From the Backup and Restoration menu, you can choose to restore the system using a
restore point file. This method only applies to the system of the same version.

Select Backup and Restore from the main menu and then select Restore System From
Restore Point, as shown in Figure 3-19.
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Figure 3-19 Console-based management — restoring the system using a restore point

Backup and Restore | Restore System From Restore Point

System Diagnosis Display all restore point information and choose o
Create Restore Point .

Restore System From Restore Point
Reinstall System
Back

Prompt

There 1s no restore point,Please generate it!

[RETURN]

Reinstalling the System

This function is available only to the RSAS hardware. System reinstallation means restoring
the system to the default configuration. Except the network settings, license file, and the
number of current scanned IP addresses, all data is restored to factory defaults during the
process. This function can be used when RSAS is faulty.

Select Backup and Restore from the main menu and then select Reinstall System, as shown
in Figure 3-20.
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Figure 3-20 Console-based management — reinstalling the system

Backup and Restore Reinstall System

System Diagnosis Reinstall the system, except system certificate and network configurat
Create Point ion.

Restore System From Restore Point
Reinstall System

Back

Reinstall System

Are you sure to reinstall the system?

3.1.3.7 System Exiting

After configuring parameters for console-based management, return to the main menu, select
Back, and then press Enter. For further configuration, log in to the system again.

3.2 Initial Configuration

This section describes how to configure RSAS for the first use. Initial configuration steps are
different for the hardware edition and virtual edition of RSAS and are described in two
separate sections.

3.2.1 Hardware Edition

The management interface can be configured only via console, while scanning interfaces can
be configured via console or web-based manager (after a license is imported). Here, the
management interface is used as an example to show to configure interfaces.

Prepare a computer, a serial cable, and terminal software for connecting to the console port
and set default parameters listed in Default Parameters.

Step1 Connect the RSAS device to the computer with the serial cable.
Step 2 Log in to the console.

a.  Use terminal software to connect to the RSAS console via a serial port.

b. Type the initial user name and password (see Default Parameters) of the console
administrator to open the main menu of the console.

Step 3 Configure the management interface. Choose Network Settings > Network Settings, set the
IP address and subnet mask of the management interface, and then press Enter to commit the
settings.
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Figure 3-21 Configuring management interface parameters

Network Settings | configure Management Interface

Display Network Settings Configure ip address and netmask of management interface.
Set DNS

Set Default Gatewa
Set Scan Interface
Add Management Interface route
Add Scanner Interface route
Delete Management In
Delete Scanner Inter Configure Management Interface
Back
This is the method to get ipv4, please use <-- or --> to change allocation method.

ipv4 allocation method [ESTd

ipv4 address [16.65.194.226

ipv4 netmask [255.255.248.0

ipv4 gateway [16.65.199.254

ipv6 allocation method [static

ipv6 address [fd01:2019:195:0:b1a9:ed7f:9f3c:b635
ipvé prefix [64

ipv6 gateway [

—End

3.2.2 Virtual Edition

VRSAS can be installed on different virtualization platforms. The method for logging in to the
console of VRSAS varies with the virtualization platform. For details, see Installing VRSAS.

\ For how to import a license, see Importing a License for the Initial Use. You can log in
4 to RSAS after importing a valid license. You must change the initial password after the
Note first login.

3.3 Web-based Management

The web-based manager provides an intuitive human-machine interaction interface for users
to manage and configure RSAS.

3.3.1 Supported Browsers

Browser Version Remarks

Firefox Latest Check whether the option of blocking pop-ups or
disabling JavaScript is selected in the browser. If yes,

Chrome Latest clear the check box.

Microsoft Edge Latest Disable the enhanced protection mode.

3.3.2 Recommended Screen Resolution

The recommended screen resolution is 1280 x 1024 pixels or higher.
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3.3.3 Web Login

Before login to the web-based manager, you must have completed Initial Configuration and
ensure that RSAS is properly connected to the network.

Open a browser and access the [P address of the management interface via HTTPS by typing,
for example, https://192.168.1.1 in the address bar. After accepting prompted risks, you can
view the web login page. Type a correct user name, password, and verification code. Click

Log In.
®  For the default user name and password, see Default Parameters.
°

When logging in for the first time, you need to change the initial password and log in
again with the new password.

3.3.4 Page Layout

The page layout for all modules of RSAS is the same, as shown in Figure 3-22.

S,

Note

The menus and work area vary with user roles and data permissions.

Figure 3-22 Page layout
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No. Area Description
1 Menu bar

Area of function menus from which you can perform further operations.

2 Work area

Area where you can perform configurations and operations and view data.
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No. Area Description
Area providing the following quick access buttons of the system:
. 2024-03-2713:58 . Jj1ows you to view the system time.
. =R, License Import/Export . gjjows you to import and export a
license.
. @ : allows you to query system information or online help.
Iy
. : allows you to upgrade the system.
Q) admin t th tlogi tandl
. . ta mana, rrent login account and lo
3 Quick access bar ows you to ge the current login accou g
out of the system.
PN
LA |
. : allows you to change the system language.
. Running status: allows you to view the system running status.

* Download recent reports: allows you to download reports on the
Report Management page.

*  System uptime: allows you to view the system uptime.

* Update available: allows you to immediately upgrade RSAS to the
available version on the System Upgrade page when there is an
upgrade prompt.

3.4 Importing a License for the Initial Use

You must import a correct license before using RSAS. To import a license, follow these steps:

Step1 Open a browser and access the IP address of the management interface via HTTPS by typing,
for example, https://192.168.1.1, in the address bar.

Step 2 After accepting prompted risks, you can view the license import page.

Step 3 Import a license file (.lic) that matches the hash value of RSAS.

—End

3.4.1 Authentication Methods for the Hardware Edition

A hardware RSAS can only be authenticated by importing a local license file that matches the
hash value of RSAS shown on the home page of the web-based manager.
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Figure 3-23 Importing a license

= NSFOCUS

3.4.2 Authentication Methods for the VM Edition

You can select any of the authentication modes to import a license to a VRSAS device.

3.4.2.1 Dongle Authentication
To authenticate vVRSAS based on a dongle, follow these steps:

Step 1 Attach the dongle USB device to vVRSAS.

Step 2 Open a browser and access the IP address of the management interface via HTTPS by typing,
for example, https://192.168.1.1, in the address bar. Then accept prompted risks.

Step 3 Select License-based authorization on the page that appears.

Figure 3-24 Authentication method — license

= NSFOCUS

License

@ seect authentication mode

ESP-L certification

o (&) [} E

Centralized
authorization

Device Hash: ~ String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use
of this device.

Technical Support:  400-818-68¢

Vendor URL:  hitps:/www.

Step 4 Click Next and import a license file (.lic) that matches the hash value granted to VRSAS.
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Figure 3-25 Importing a local license

= NSFOCUS

—End

3.4.2.2 Cloud-based Authorization

To authenticate VRSAS by using NSFOCUS security cloud, follow these steps:

Step1 Open a browser and access the IP address of the management interface via HTTPS by typing,
for example, https://192.168.1.1, in the address bar. Then accept prompted risks.

Step 2 Select Security cloud-side authentication on the page that appears.

Figure 3-26 Authentication method — NSFOCUS security cloud

= -NSFOCUS

License

0 Select authentication mode

Lo

Centralized

n E
urity cloud-side License-based

authentication ESP-L certification

Device Hash: String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use
of this device

Technical Support:  400-818-6868

Vendor URL:  hitps:/Mww.nsfocus.com

Step 3 Click Next to select an authentication server and import the prepared license file (.lic).
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Figure 3-27 Importing a license for cloud-based authorization
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3.4.2.3 Centralized Authorization

To authenticate VRSAS by using a CAA platform, follow these steps:

Step1 Open a browser and access the IP address of the management interface via HTTPS by typing,
for example, https://192.168.1.1, in the address bar. Then, accept prompted risks.

Step 2 Select Centralized authorization on the page that appears.

Figure 3-28 Authentication method — CAA platform
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El

ESP-L certification

String provided to NSFOCUS (support@nsfocusglobal.comm) for generating a license for use
of this device

400-818-6868

itps:/www.nsfocus.com

Step 3 Click Next. Set the IP address respectively for VRSAS and the CAA platform.
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Figure 3-29 Configuring an authoritative server for centralized authorization
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Step 4 Perform authorization on the CAA management platform.

For details, see the respective user guide of the CAA management platform.

—End

3.4.2.4 ESP-L Authorization

Open a browser and access the IP address of the management interface via HTTPS by typing,
for example, https://192.168.1.1, in the address bar. Then accept prompted risks. Select ESP-
L certification and click Next. Wait until ESP-L issues a license.

Figure 3-30 Authentication method — ESP-L
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A Default Parameters

Choose Administration > Status > System Status to check the factory version and view its
factory defaults.

V6.0R02F00 and Later

Default Network Settings

Interface IP Address Subnet Mask
Management interface 192.168.1.1 255.255.255.0
Scan interface 1 192.168.2.1 255.255.255.0

Communication Parameters of the Console Port

User Name Password Baud Rate Data Bits

conadmin conadmin 115200 8

Default User Accounts

Role User Name Password
System administrator admin admin
Auditor auditor auditor

Versions Earlier Than V6.0R02F00

Default Network Settings
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Interface IP Address Subnet Mask Gateway IP | Negotiation
Address Mode
Scan interface 1 | 192.168.1.1 255.255.255.0 192.168.1.254 auto
Management 1.1.1.1 255.255.255.0 N/A N/A
interface

Communication Parameters of the Console Port

User Name Password Baud Rate Data Bits

conadmin nsfocus 115200 8

Default User Accounts

Role User Name Password
System administrator admin nsfocus
Auditor auditor
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